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  مهندسی شناسیلرزه : اول فصل -1

 (Mantle) جبه ،(Core) هسته قسمت سه به نزمی کره شناخت. را زمین کره داخلی سیستم باید زلزله شناخت براي

 و جامد داخلی ههست که است خارجی يهسته و داخلی يهسته املش نیز هسته شود.می تقسیم (Crust) پوسته و

  است. مایع خارجی يهسته

  

  

  

 و ترداغ يلایه روي که (Lithosphere) لیتوسفر نام به خارجی صلب يلایه یک است: قسمت دو داراي پوسته

 هايقاره است. ناپیوسته تکتونیکی صفحات مرز لیتوسفر دارد. قرار (Asthenosphere) استنوسفر نام به تريضعیف

  دارند. قرار لیتوسفر روي هااقیانوس و

 .است صلب صفحات تعداد از متشکل لیتوسفر نظریه این اساس بر :Tectonic) (Plate ايصفحه تکتونیک ينظریه

 هب نسبت صفحات این است. شده پوشیده کوچکتر صفحات تعدادي و بزرگ لیتوسفري يصفحه 6 از زمین سطح

 اتصفح این مشترك مرز طول در هاآتشفشان و هازلزله مانند یشناسزمین هايفعالیت و کنندمی حرکت یکدیگر

 شودیم مشاهده پیوسته بوقوع هايلرزهزمین ينقشه و زمین لیتوسفري صفحات ينقشه مقایسه با هستند. متمرکز

 هازلزله نبی ارتباط به پی دانشمندان طریق این از اند.داده روي تکتونیکی صفحات بین مرز در هازلزله همه تقریبا که

  اند.برده تکتونیکی صفحات مشترك فصل با

    
 تا 4 بین لسا هر آرم اقیانوس و شمالی آمریکاي صفحات مثلا حرکتند، حال در یکدیگر به نسبت لیتوسفري صفحات

 انهم هامرز (این دارد وجود رفتار نوع سه صفحات این مشترك مرز در کنند.می حرکت کدیگری به نسبت مترسانتی 6
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 صفحات مرز در که دارند وجود هم هاگسل از سري یک شد، خواهد داده توضیح آنها يدرباره بعدا که هستند هاگسل

  :است) کم بسیار آنها تعداد و ندارند قرار لیتوسفري

 جدید لیتوسفر ایجاد با همراه که شده دور یکدیگر از صفحات مرزها این در : (Divergent) واگرا مرزهاي .1

 وسط ماهی گرده مثلا شود.می ایجاد هااقیانوس وسط در اکثرا و بوده شکل ماهی گرده نواحی این شد.بامی

 اطلس. اقیانوس

 فشار زمین پوسته به و کرده برخورد یکدیگر با صفحات مرزها این در : (Convergent) همگرا مرزهاي .2

 گردی يصفحه زیر است ممکن صفحه یک فشار، اثر در اینکه یا و کنندمی ایجاد را جدید هايکوه و آورندمی

 .گرددمی ایجاد عمیق هايخندق نقاط این در ببرد. زمین گوشته داخل به خود با را لیتوسفري مواد و رفته

 است. صعودي عربستان صفحه و ایران صفحه مشترك حد تقارب از ناشی زاگرس جبال سلسله مثلاً

 رزهام نوع این در لغزند.می افقی صفحه یک در یکدیگر به سبتن صفحات این : (Sliding) لغزشی مرزهاي .3

 شود.می منهدم ايپوسته نه و شودمی ایجاد جدیدي پوسته نه

  
  

 خود مرز در لیتوسفري صفحات :Theory) Rebound (Elastic هازلزله وقوع براي الاستیک برگشت نظریه

 گسل طرف دو هاسنگ در تنش و کرنش ایجاد موجب تحرک این کنند.می حرکت ارامی به ها)گسل همان (یعنی

 شکل )برشی (نیروي اصطکاك نیروي يبوسیله یا داده الاستیک تغییرشکل مرزها این در هاصخره و هاسنگ کند.می

 هاخرهص و هاسنگ مقاومت بر که برسد حدي به شده ایجاد تنش و تغییرشکل اینکه تا کنند،می حفظ را خود اولیه

 جاابهج ناگهانی صورت به و لغزندمی یکدیگر به نسبت خراش با هاصخره هنگام این در کند. غلبه گسل رفط دو در

 ود.شمی منتشر امواج شکل به و شودمی هاسنگ در شده ذخیره الاستیک انرژي شدن رها موجب مزبور لغزش شوند.می

 دارد. نام (Earthqueke, Seismic) زلزله که هشد جهات همه در شدیدي هايحرکت دچار زمین امواج، این اثر در

 و اجسام خود مسیر در امواج این کنند.می جاجابه خود با را شده ازاد انرژي و شده ساطع جهات همه در ايلرزه امواج

 که است امواجی حرکت مانند امواج این حرکت رسانند.می آسیب آنها به و داده حرکت را خود راه سر هايساختمان

 کرنش انرژي تدریجی شدن جمع نتیجه هاگسل حرکت (بنابراین شودمی ایجاد آب در سنگ یک پرتاب خاطر به

  گویند)می الاستیک برگشت آن به که است هاسنگ توده در مربوطه تنش ناگهانی شدن رها و برش از ناشی الاستیک



5 

 

  

    
  

 (طول گسل از کیلومترها طول در نرژيا شدن آزاد ولی شودمی شروع نقطه یک از مسلما هاگسل حرکت 

 دهد.می رخ گی)پاره

 اثر در کمی الاستیک انرژي باشد، کم نسبتا گسل محل در انها اتصال و هاصخره مقاومت کهصورتی در 

 شده ایجاد هايزلزله و بوده کم نیز شده زادآ انرژي و تغییرشکل و شده جمع گسل طول در تغییرشکل

 فشار صورت این در باشد، زیاد خیلی گسل محل در آنها اتصال و هاسنگ مقاومت اگر اما باشد.می کوچک

 افتاده اتفاق هاسنگ محل در مهیبی لغزش سرانجام و شده جمع سال صدها یا و هاده براي است ممکن وارده

  شود. ایجاد بزرگ يزلزله و

 معرف گسل کند.می جدا هم از را گیسن مجموعه دو که ايناپیوسته سطح از است عبارت گسل : (Fault) گسل

 همه شود.می ناشی آن از زلزله یک در زمین حرکت منشا و دهدمی رخ زمین حرکات آن طول در که است ايصفحه

  داریم. گسل هم تکتونیکی صفحات مرز از خارج در و نیستند تکتونیکی صفحات به مربوط هاگسل

 هايعکس از استفاده با حتی تواننمی را دیگر برخی لیو هستند نمایان زمین سطح در هاگسل از برخی 

  داد. تشخیص هوایی
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 در نقطه این به دهد. رخ زلزله است ممکن گسل از اينقطه هر در : Focus or (Hypocenter( زلزله کانون

  شود.می ساطع اطراف به نقطه این از امواج گویند.می کانون گسل عمق

  دارد. قرار زلزله کانون بالاي در درست و زمین سطح در که است اينقطه : enter)(Epic رومرکز-زلزله مرکز

  
 همدیگر) از هاسنگ گسیختگی ي(نقطه زلزله کانون و بوده مختلف هاگسل عمق : (Focal Depth) زلزله عمق

  گویند.یم زلزله عمق را زمین سطح از هاصخره گسیختگی نقطه فاصله باشد. تواندمی گسل صفحات این از عمقی هر در

 يبند تقسیم (زلزله سیستان و بلوچستان) عمیق و (زلزله بم) سطحی نوع دو به عمق حسب بر هازلزله 

 600 تا 300 عمق از عمیق هايزلزله ولی است کیلومتر 10 از کمتر سطحی هايزلزله عمق شوند.می

  (مثال چراغ قوه) شوند.می منتشر کیلومتري

 محسوس هم دور فواصل در عمیق هايزلزله حالیکه در است کوچک نسبتاً سطحی هايزلزله اثر حوزه 

   باشند.می

 هستند سطحی نوع از همواره مخرب هايزلزله که است این در مهندسی نظر از زلزله نوع دو عمده تفاوت 

  دارند. قرار متريکیلو 50 عمق در حداکثر مخرب هايزلزله ندارند. چندانی تخریبی اثر عمیق هايزلزله ولی

  ها:گسل سرعت

 سرعت کنند.می حرکت زلزله وقوع هنگام به فقط دیگر برخی حالیکه در حرکتند، حال در همواره هاگسل برخی

  است. سال در مترسانتی 10 تا 3 حدود آنها سرعت بیشترین است. متفاوت رکتح الح در فعال هاگسل

  ها:گسل طول
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 مترکیلو 1000 تا طولانی هايگسل باشد. کیلومتر صدها تا متر چند از است ممکن و است متفاوت بسیار هاگسل طول

  دارد. مستقیم ارتباط شود)می جاجابه که گسل از طولی (یعنی گسلش طول با زلزله رگیزب دارند. طول

   :فعال گسل

 د.نامنمی فعال گسل را کرد خواهند حرکت نیز آینده در و نموده حرکت گذشته سال هزار چندین طی که هاییگسل

 نظیر بزرگ هايپروژه طرح هنگام به دارد، وجود فعال گسل که دهدمی رخ مناطقی در معمولا زلزله که آنجایی از

 فادهاست مورد طرح زلزله برآورد در و شود مشخص بایستی منطقه فعال هايگسل مشخصات فاصله ها،نیروگاه و سدها

  گیرد. قرار

  هاگسل انواع

 ندارند. حرکتی هیچ و بوده ساکن هم به نسبت گسل طرف دو هايصخره : کنسا گسل .1

 

 طرف دو هايصخره گسل نوع این در : Fault) Subduction or (Normal کششی یا نرمال گسل .2

 ایجاد رايب کشش کهصورتی در و کنندمی کشش ایجاد گسل در و اشتهد یکدیگر از شدن جدا به تمایل گسل

 .کندمی حرکت پایین به دیگر قطعه به نسبت قطعه یک د،باش کافی گسیختگی

 شوند.می ایجاد واگرا تکتونیک صفحات مرز طول در نرمال، هايگسل اکثر 

 

 فشردن به تمایل گسل طرف دو هايصخره : Fault) Thrust or (Reverse فشاري یا معکوس گسل .3

 قطعه یک ،باشد کافی گسیختگی ایجاد براي فشار که موقعی کنند.می ایجاد فشار گسل در و داشته یکدیگر

  .کندمی حرکت بالا سمت به گسل صفحه امتداد در دیگر قطعه به نسبت

  شوند.می ایجاد همگرا صفحات برخورد محل در فشاري هايگسل اکثر

  

 تقریبا گسل صفحه یک طول در حرکت : (Strike-Slip Fault) امتدادلغز یا جانبی لغزش هايگسل .4

 حرکت باشد. چپگرد یا راستگرد به تواندمی هاگسل این حرکت گیرد.می صورت جانبی لغزش ورتص به قائم

 رکتح کند، نگاه گسل به رو و بگیرد قرار گسل این طرف هر روي شخصی اگر اینکه یعنی راست سمت به

 برعکس. و باشد او راست طرف به همیشه مقابل طرف
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  ایران هايگسل ينقشه

 هزلزل امواج

  شود.می منتشر مختلف هايموج صورت به زلزله کانون از شده آزاد انرژي

 Surface) (Wave سطحی موج و Body) (wave حجمی موج شود. می منتشر زلزله کانون از موج نوع دو

 زمین سطح مجاورت به محدود سطحی امواج حرکت اما شود،می منتشر هاصخره جسم و حجم داخل در حجمی امواج

 حیسط امواج سرعت یابد.می کاهش تدریج به زمین سطح از فاصله شدن زیاد با آنها از ناشی هايتغییرمکان و است

 است. حجمی امواج سرعت از کندتر

  زلزله: امواج انواع

 حجمی امواج .1

 به شوند،می پخش که همچنان که معنی بدین است. صوتی امواج مانند موج این طبیعت : P امواج -الف

 .شوندمی منتشر خود نوسان راستاي در فقط امواج این گردد.می هاصخره شدن کشیده و فشردن باعث بمتناو طور

 ممکن آنها از قسمتی رسند،می زمین سطح به زمین عمق از امواج این که وقتی P امواج مانند صوت طبیعت علت به

 مکنم باشد، گوش شنوایی حد در امواج نای فرکانس اگر و شوند منتشر اتمسفر داخل به صوتی امواج صورت به است

 که موجی اولین و دارد بالاتري سرعت زلزله امواج همه از موج این باشد. شنیدن قابل انسان و حیوانات وسیله به است

 صدا به و دادن تکان باعث که است صوتی غرش یک مانند امواج این اثر است. P موج رسدمی نگاريلرزه ایستگاه به

 مواد از هم صوتی امواج مانند P امواج است. برشی امواج برابر 107 حدود آن سرعت و شودمی هانجرهپ آوردن در

 موجب P موج کنند.می عبور آتشفشانی) مذاب مواد و دریاها آب (مانند مایع مواد از هم و زمین) پوسته (مثل جامد

  ).S موج (همانند شودمی قائم و افقی ارتعاش ایجاد
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 موج یک آن در که طنابی حرکت (مانند است موج انتشار امتداد بر عمود امواج این ارتعاش : S امواج -ب

 دریافت P امواج از پس ثانیه چند S امواج بنابرابن و است P امواج سرعت از کمتر S امواج سرعت شود).می ایجاد

 نتشارا هاسنگ در کههنگامی بنابراین ،شوند مرتعش پایین و بالا سمت به هاسنگ ذرات شودمی باعث S موج شود.می

 هايتغییرشکل ایجاد با S امواج کهآنجایی از کنند.می ایجاد برش انتشار، جهت بر عمود امتداد در آنها در یابند،می

 هايقسمت از تواندنمی S موج بنابراین ندارد، را برشی هايتغییرشکل قابلیت مایعات و کند،می حرکت مواد در برشی

 امواج این حرکات شود.می زمین سطح در قائم و افقی ارتعاشات موجب S موج کند. عبور هااقیانوس مانند زمین ایعم

  است. P موج از بیشتر بسیار S موج نوسان دامنه است. موثر خیلی هاساختمان به رساندن آسیب در که است

  
 امواج سطحی .2

 جمو این .ندارد قائم اثر که تفاوت این با است S موج شبیه خیلی موج این خصوصیات  : Love امواج -الف

 تکان لاو امواج از ناشی اثر آورد.می در ارتعاش به زمین سطح موازي و افقی يصفحه یک در پهلو به پهلو از را زمین

 روي طفق و ندکن عبور توانندنمی آب میان از لاو امواج .کندمی ایجاد خسارت اینرو از و باشدمی ساختمان پی به افقی

  برند.می جلو و عقب به را آنها و گذارندمی اثر هادریاچه هايکناره سطحی هايآب

  
 جهت در هم و قائم جهت در هم هاسنگ دادن حرکت باعث ریلی امواج  : (ریلی) yleighaR امواج -ب

 اب گیرد.می صورت مواد سطح يرو بر فقط و امواج انتشار امتداد بر قائم يصفحه یک در حرکت این شوند.می افقی

 ند.کنمی حرکت لاو امواج از کندتر ریلی امواج کنند.می حرکت بیضی مسیر یک در هاصخره روي قطعات امواج، عبور

   بگذارند. تاثیر دریاها آب از زیادي هايحجم روي در توانندمی حرکتشان قائم مولفه علت به ریلی امواج
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  نگاريلرزه ایستگاه هس کمک به زلزله مرکز تعیین

 عرضی موج از قبل طولی موج بنابراین و است عرضی امواج از بیشتر (P) طولی امواج سرعت که دیدیم قبل قسمت در

 لشک داشتن با پس است. P امواج از بیشتر S امواج ارتعاش دامنه دیگر طرف از شود.می ثبت نگارلرزه توسط

 نتعیی نگاريلرزه ایستگاه از را عرضی و طولی امواج زمانی فاصله توانمی P و S امواج سرعت و زلزله یک نگاشتشتاب

  نمود.

  
  : ایستگاه به S موج رسیدن زمان

s

s

d
t
V


 
  : ایستگاه به P موج رسیدن زمان

p

P

d
t
V


 
  نگاري:لرزه ایستگاه تا زلزله مرکز فاصله
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   برشی: امواج سرعت
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  : P امواج سرعت
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1 نگاريلرزه ایستگاه سه در اگر بنابراین 2 3, ,S S S، 1 فواصل 2 3, ,d d d سپس و باشد، آمده دست به زلزله مرکز از 

1 مراکز به دوایري 2 3, ,S S S 1 هايشعاع و 2 3, ,d d d مشخص را زلزله مرکز هادایره این برخورد محل کنیم، رسم 

  کند.می
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  2800 نامهآیین کلیات : دوم فصل -2

  دفه -2-1

  که:طوري به است زلزله برابر در هاساختمان ياجرا و طرح براي ضوابط حداقل تعیین 2800 نامهآیین هدف

 هايزلزله در همچنین برسد. حداقل به جانی تلفات و شود حفظ دشدی هايزلزله در ساختمان ایستایی الف)

  نشود. وارد ساختمان به ايسازه يعمده آسیب متوسط و خفیف

 و کنند حفظ را خود برداريبهره قابلیت متوسط و خفیف هايزلزله در »زیاد اهمیت« با هايساختمان ب)

  برسد. حداقل به ايغیرسازه و ايسازه خسارت »متوسط اهمیت« با هاساختمان در

 ،ايسازه يعمده آسیب بدون ،شدید خیلی هايزلزله عقوو زمان در »زیاد خیلی اهمیت« با هايساختمان پ)

  )2011اي فوکوشیما در ژاپن در سال (مثل نیروگاه هسته کنند حفظ را خود وقفه بدون برداري بهره قابلیت

  

  
 از کمتر ساختمان، مفید عمر سال 50 در آن قوعو احتمال که است ايزلزله شدید): (زلزله طرح زلزله

  .سال) 475 بازگشت دوره با زلزله (یعنی باشد 10%

 عمر سال 50 در آن وقوع احتمال که است ايزلزله متوسط): یا خفیف (زلزله برداريبهره سطح زلزله

  سال). 10 بازگشت دوره با زلزله (یعنی باشد 5/99 از بیشتر ساختمان، مفید

  کاربرد دحدو -2-2

 رود.می کار به غیرمسلح بنایی مصالح و فولادي ،مسلح بتن هايساختمان طراحی براي نامهآیین این

  



13 

 

 این مشمول ايهسته هاينیروگاه و دریایی هايهساز ،هااسکله ،هاپل سدها، مانند خاص هايساختمان 

 .شوندنمی نامهآیین

  
  

 .شوندنمی نامهآیین این مشمول شوندمی هساخت خشت و گل با که سنتی هايساختمان 

  

  (مربوط خاك و زمین) ژئوتکنیکی ملاحظات -2-3

. کیلومتر) 10تا  5شود (کمتر از  ساخته (Near Field) فعال گسل روي بر ساختمان نباید کلی طور به 

  .ندشونامیده می (Far Field)هاي دور از گسل اصطلاحا زلزله

 
 شوند لغزش زمین ،زیاد نشست ،(Liquifaction) روانگرایی دچار است ممکن زلزله اثر در که هاییزمین در 

 گیرد. صورت ویژه مطالعات باید باشد، حساس رس خاك داراي آن زمین یا و
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 خاك یازن صورت در و شود بررسی ژئوتکنیکی هايناپایداري باید هستند، روانگرایی مستعد که هاییزمین در 

 اشباع از آبو  کم تراکم با ايماسه خاك که که دهدمی رخ هاییزمین در اصولا روانگرایی گردد. بهسازي

متر از  10. روانگرایی عموما در عمق کمتر از باشد متر 10 از کمتر آنها در زمینی زیر آب تراز سطح و باشند

وجود دارد، مناطق شمالی افتد. از جمله مناطقی که در ایران احتمال وقوع روانگرایی سطح زمین اتفاق می

 کشور بخصوص در مجاورت دریاهاست.

  
 نقشه روانگرایی کشور

 انجام شیب پایدارسازي نیاز صورت در و شیب پایداري مطالعات باید شیب روي بر ساختمان احداث براي 

 گیرد.

 یبش وير بر ساختمان صورتیکه در و شود. ساخته افقی سطح یک روي بر المقدورحتی باید ساختمان پی 

  باشد. داشته قرار افقی سطح یک روي بر ساختمان پی از قسمت هر باید شود ساخته

  

  معماري ملاحظات -2-4

 کنند.ن وارد ضربه یکدیگر به هاساختمان زلزله اثر در تا شوند جدا یکدیگر از انقطاع درز با باید هاساختمان 

 
 و آمدگیپیش بدون و هم بر عمود امتداد دو در تقارنم و ساده شکل به المقدورحتی تا باید ساختمان پلان 

ارن ي نامتقتوان از درز انقطاع استفاده کرد و سازهها میبراي متقارن کردن پلان سازه باشد. زیاد رفتگیپس

 را به چند سازه کوچکتر تبدیل کرد.
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 باشد.متر  5/1 بزگتر نباید المقدورحتی ساختمان (کنسول) هايطره 

 
 شود. خودداري دیافراگم در یکدیگر مجاور و بزرگ هايبازشو ایجاد از 

 
همچنین  شود. خودداري بزرگ هايدهانه و هاطره روي بر سنگین تاسیسات و ساختمانی اجزاي دادن قرار از 

 قرار نگیرد. بارها و تجهیزات سنگین در طبقات فوقانیشود که توصیه می

   
(اختلاف  شود.شود. زیرا باعث ایجاد ستون کوتاه می خودداري امکان حد تا هاکف در سطح اختلاف ایجاد از 

 هر طبقه ریزي اجرا کرد تا از به وجود آمدن اختلاف تراز در دال کفتوان با پوکهسطح در تراز طبقات را می

  جلوگیري شود)

 
 اريخودد طبقات جرم تغییرات بالتبع و ارتفاع در طبقات زیربناي مساحت (ناگهانی) افزایش یا و کاهش از 

 شود.
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  ايسازه پیکربندي ملاحظات -2-5

 تا شوند داده قرار هم روي بر امکان حد تا مختلف طبقات در کنندمی تحمل را قائم بارهاي که عناصري 

 .نگیرد صورت افقی عناصر واسطه به یکدیگر به عناصر این بار لقاانت

 
 نیروها نتقالا که شوند، گرفته نظر در صورتی به کنند می تحمل را هزلزل از ناشی افقی نیروهاي که عناصري 

 ارقر قائم صفحه یک در کنند می کار هم با که عناصري و شوند انجام مستقیم طور به شالوده سمت به

 .باشند داشته

     
  

  
 این زا ناشی یچشپ که شوند گرفته نظر در صورتی به زلزله از ناشی افقی نیروهاي برابر در مقاوم عناصر 

 در طبقه در سختی مرکز و جرم مرکز فاصله است مناسب منظور این براي .برسد حداقل به طبقات در نیروها

به معنی مرکز جرم ساختمان  CM(توضیح:  گردد امتداد آن در ساختمان بُعد درصد 5 از کمتر امتداد، هر

 .باشد)می Center of Stiffnessیا به معنی مرکز سختی ساختمان  CKاست و  Center of Massیا 
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 .باشد شده تامین آن در مناسب مقاومت و پذیريشکل که گردند طراحی نحوي به آن اجزاي و ساختمان 

هرچقدر  د.باشمی گسیختگیقبل از رسیدن به حد  قابلیت جذب و استهلاك انرژي زلزلهپذیري منظور از شکل

هاي پذیر ساختمانبراي طراحی شکل طراحی کرد.نیروي کمتري اي توان آنرا برباشد، می پذیرترشکلسازه 

را رعایت  هاي بتن آرمهمقررات ملی ساختمان 9مبحث و  هاي فولاديساختمان 10ضوابط خاص مبحث باید 

 .)پذیر و تنومندهاي انعطاف(مثال باد براي درخت کرد

 دیتایل اتصال تیر به ستون بتنی

   
 نحوي به طراحی شود، می استفاده جانبی بار براي خمشی قاب سیستم از آنها رد که هاییساختمان در 

 .شوند خرابی دچار تیرها از دیرتر هاستون امکان حد تا که گیرد صورت

د. زیرا باید مدنظر قرار بگیر ستون قوي-تیر ضعیفي طراحی به صورت هاي قاب خمشی فلسفهدر سیستم تفسیر:

ها است. ولی از بین رفتن قسمتی از ستون باعث فروریختن یک به یک سقف عیوضشکست مشکست یک تیر، نوعی 

ها ها کمتر از تیرها است. بنابراین باید تیرها زودتر از ستونشود. علاوه بر این شکل پذیري ستونو انهدام کلی سازه می

 پذیري مناسب خود انرژي زلزله را مستهلک نمایند.تسلیم شده و با شکل

    
 

 حرکت براي مزاحمتی امکان حد تا که شوند اجرا طوري نماها و داخلی دیوارهاي مانند اي،غیرسازه اعضاي 

 ازهس سیستم با اعضا این اندرکنش اثر صورت، این غیر در .نکنند ایجاد زلزله وقوع زمان در ايسازه اعضاي

 .شود گرفته نظر در سازه تحلیل در باید

 

 هايزیرا ستون .شود خودداري الامکان حتی ،هازیرزمین نورگیرهاي در خصوص به ،کوتاه هايستون ایجاد از 

 شوند.کنند و زودتر خراب میکوتاه به دلیل سختی بسیار بالایی که دارند، نیروي بسیار بیشتري را جذب می
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  فرمولاسیون ستون کوتاهاثبات : 
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 خودداري ارتفاع و پلان در مختلف امتدادهاي در ايسازه مختلف هايسیستم کارگیري به از المقدور حتی 

 د.شو

  

  کلی ضوابط -2-6

 از ختلفم عناصر زلزله وقوع زمان در تا باشند پیوسته هم به مناسبی نحو به باید ساختمان باربر عناصر کلیه 

 هاقاب باربر، قائم عناصر به باید هاکف مورد، این در کند. عمل یکپارچه طور به ساختمان و نشده جدا یکدیگر

 زلزله از یناش نیروهاي دیافراگم یک صورت به بتوانند که طوري به اشند،ب متصل مناسبی نحو به دیوارها، یا و

 کنند. منتقل جانبی باربر عناصر به را

 
 هر در و باشد زلزله از ناشی افقی ي نیروها تحمل به قادر هم بر عمود افقی امتداد دو هر در باید ساختمان 

 گیرد. صورت مناسب ايگونه به الودهش به افقی نیروهاي انتقال باید نیز امتدادها این از یک
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 نتأمی براي باشد، می پایه تراز روي از طبقه آن ارتفاع صدم یک برابر طبقه هر در انقطاع درز عرض حداقل 

 روي از طبقه آن ارتفاع هزارم پنج برابر باید مجاورحداقل زمین مرز از ساختمان طبقه هر فاصله منظور، این

 طبقه هشت با هايساختمان سایر در یا و »زیاد« و »زیاد خیلی اهمیت با« هايانساختم در باشد. پایه تراز

 ربدرض طبقه آن طرح نسبی جانبی مکان تغییر ضرب حاصل از کمتر نباید طبقه هر در عرض این بیشتر، و

 عادلم ايفاصله رعایت به ملزم یکدیگر، مجاور هايساختمان از هریک شود. گرفته نظر در ،R رفتار ضریب

 ار انقطاع درز فاصله باشد.می طبقه هر در ساختمان آن طرح نسبی جانبی تغییرمکان در 0.5R حاصلضرب

 ،شود می خرد آسانی به ساختمان دو برخورد اثر بر زلزله، وقوع هنگام در که مقاومت کم مصالح با توان می

  .باشد سازي به و کردن گزین جاي قابل سادگی به زلزله از پس که طوري به نمود پر مناسبی نحو به

  اهمیت حسب بر هاساختمان بنديگروه -2-7

  :شوند می تقسیم چهارگروه به اهمّیت نظر از ها ساختمان نامه آیین این در

  »زیاد خیلی اهمیت با« هاساختمان -1 گروه

 در وقفه و دارد خاص همیتا زلزله وقوع از پس آنها بودن استفاده قابل که دارند قرار هاییساختمان گروه، این در

 ها،درمانگاه و هابیمارستان :مانند شود،می خسارات و تلفات افزایش موجب مستقیم غیر طور به آنها از برداريهبهر

 مراکز ها، فرودگاه مراقبت هايبرج رسانی،برق تاسیسات و هانیروگاه آبرسانی، تاسیسات و مراکز نشانی،آتش مراکز

 آنها از هاستفاد که هاییساختمان تمام کلی بطور و سانیرکمک مراکز ،انتظامی تاسیسات تلویزیون، و رادیو مخابرات،

 در مضر و سمی مواد گسترده انتشار موجب آنها خرابی که تاسیساتی و ها ساختمان .باشد می مؤثر امداد و نجات در

  .گردندمی منظور هاانساختم گروه اینجزء  شوند می زیست محیط براي درازمدت و مدت کوتاه

  

 »با اهمیت زیاد« هايساختمان -2 گروه

 :است زیر دسته سه شامل گروه این

 مساجد، ،هاي بعدي)(انقطاع در نسل مدارس :مانند شود،می زیاد تلفات موجب آنها خرابی که هاییساختمانالف) 

 هک سرپوشیده فضاي هر یا مسافري، هايرمینالت بزرگ، هايفروشگاه اجتماعات، سالن تئاترها، و سینما ها، استادیوم

 .باشد سقف یک زیر در نفر 300 از بیش تجمع محل

 کلی طور به و ها،کتابخانه ها،موزه: مانند شود،می ملی ثروت رفتن دست از سبب هاآن خرابی که هاییساختمانب) 

 .شودمی دارينگه ارزش پر آثار یا و ملی مدارك و اسناد هاآن در که مراکزي

 :انندم شود،می وسیع سوزيآتش یا و زیست محیط آلودگی موجب هاآن خرابی که صنعتی تاسیسات و هاساختمانپ) 

 .رسانی گاز مراکز و سوخت انبارهاي ها،پالایشگاه
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 »با اهمیت متوسط«هاي ساختمان -3گروه 

 گروه سه در شده عنوان هايساختمان بجز نامه، آیین این مشمول هايساختمان کلیه شامل هاساختمان گروه این

 ها، کارگاه انبارها، چندطبقه، هايپارکینگ ها،هتل تجاري، و اداري و مسکونی هايساختمان :مانند است، دیگر

  .غیره و صنعتی هايساختمان

  

 »با اهمیت کم«هاي ساختمان -4گروه 

 :است زیر دسته دو شامل گروه این

 کم بسیار هاآن در تلفات بروز احتمال و شود می حادث آنها خرابی از کمی نسبتاً  تخسار که هاییساختمانالف) 

  .داريمرغ هايسالن و کشاورزي انبارهاي مانند است،

  .است سال 2 از کمتر ها آن از برداري بهره مدّت که موقت هايساختمانب) 

  

 شکل حسب بر ها ساختمان بندي گروه -1-8

 :شوند می تقسیم زیر شرح به نامنظم و منظم گروه دو به شکل برحسب ها ساختمان

  

  :منظم هايساختمان -1-8-1

  .باشند زیر هايویژگی کلیه داراي که شودمی اطلاق ساختمانها از گروهی به

 

  پلان در بودن منظم-1-8-1-1

 رعناص معمولاً  که ساختمان، اصلی محورهاي به نسبت متقارن تقریباً  یا و متقارن شکل داراي ساختمان پلانالف) 

 ،پلان در آمدگیپیش یا فرورفتگی وجود صورت در چنین، هم. باشد دارند، قرار ها آن امتداد در زلزله، برابر در مقاوم

  .ننماید تجاوز امتداد آن در ساختمان خارجی بعد %25 از امتداد هر در آن اندازه
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 بعد %20 از ساختمان متعامد امتداد دو از یک هر در سختی مرکز و جرم مرکز بین فاصله طبقه هر در ب)

  .نباشد رتبیش امتداد آن در ساختمان

  
  

    
  ساختمان نامنظم با خروج از مرکزیت (نامناسب)  ساختمان منظم (مناسب)
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 و نبوده بیشتر درصد %50 از مجاور طبقات به نسبت طبقه هر دیافراگم سختی در ناگهانی تغییراتپ) 

  .ننماید تجاوز دیافراگم کل سطح درصد %50 از آن در بازشو سطوح مجموع

  
 وجود طبقات در جانبی باربر اجزاي صفحه تغییر مانند انقطاعی زمین، به جانبی نیروي انتقال مسیر درت) 

  افتد.ها اتفاق میعموما در پارکینگ .باشد نداشته

 
 با %20 زا بیشتر تصادفی، پیچش احتساب با مان،ساخت انتهاي در نسبی تغییرمکان حداکثر ههرطبق درث) 

  .باشد نداشته اختلاف طبقه آن در ساختمان انتهاي دو نسبی تغییرمکان متوسط

 ارتفاع در بودن منظم -1-8-1-2

 بام استثناي به اي،طبقه هیچ جرم که طوري به باشد یکنواخت تقریباً ساختمان، ارتفاع در جرم توزیعالف) 

  .باشد نداشته تغییر %50 از بیشتر خود زیر طبقه جرم به بتنس بام خرپشته و
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 متوسط %80 از کمتر یا و خود روي طبقه جانبی سختی %70 از کمتر ايطبقه هیچ در جانبی سختیب) 

بند باشد،  این در شده عنوان محدوده از کمتر آن جانبی سختی که ايطبقه .نباشد خود روي طبقه سه سختی

هاي چند طبقه واقع هایی در طبقه همکف ساختمان(در مغازه .شودمی نامیده» طبقه نرم« و شده تلقی ذیرپانعطاف

  شده است).
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 طبقه هر مقاومت. نباشد خود روي طبقه جانبی مقاومت درصد %80 از کمتر ايطبقه هیچ جانبی مقاومتپ) 

 ايطبقه .نمایندمی تحمل نظر مورد جهت در را طبقه برش که است مقاومی اجزاي کلیه جانبی مقاومت مجموع با برابر

  شود.نامیده می »طبقه ضعیف«تلقی شده و  ضعیفباشد،  بند این در شده عنوان حدود از کمتر آن جانبی مقاومت که

 نامنظم هايساختمان -1-8-2

  باشند. 1-8-1 بند وابطض ویژگی چند یا یک فاقد که شودمی اطلاق هاییساختمان به نامنظم هايساختمان

 ايسازه سیستم برحسب هاساختمان بنديگروه -1-9

  :شوندمی بنديطبقه زیر هايگروه از یکی در ايسازه سیستم برحسب هاساختمان

 باربر دیوارهاي سیستم -1-9-1

 و اربرب دیوارهاي سیستم، این در. باشد می قائم باربري براي ساختمانی هايقاب فاقد که است ايسازه سیستم نوعی

 رهايدیوا وسیله به نیز جانبی نیروهاي برابر در مقاومت و نموده تحمل را قائم بارهاي عمدتاً شده مهاربندي هايقاب یا

  .شودمی تامین شده مهاربندي هايقاب یا و کنندمی عمل برشی دیوارهاي صورت به که باربر

  

 ساده ساختمانی قاب سیستم -1-9-2

 و شده تحمل ساده اتصالات با ساختمانی هايقاب توسط عمدتاً  قائم بارهاي آن در که است ايسازه سیستم نوعی

 رجینیوخ اتصالات با هايقاب سیستم .شودمی تامین بادبند یا برشی دیوارهاي توسط جانبی نیروهاي برابر در مقاومت

 .اند گروه این از نیز قائم هايمهاربندي با همراه (رکابی)

  .برد کار به محوربرون یا محورهم صورت به توان می را شده مهاربندي هايقاب سیستم، دراین
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  اتصال خورجینی

  
  (همگرا) محورهمانواع قابهاي مهاربندي 

  

  
  EBF) ا(واگر برون محورانواع قابهاي مهاربندي 

  

  زلزله مستهلک شود.شود تا نیروي پیوند موجب می تیر هاي پلاستیک برشی در اینتغییرشکل

لزله را تواند نیروي برشی زاگر تیر پیوند به صورت لانه زنبوري باشد، به دلیل اینکه مقاومت برشی آن کم است نمی

مستهلک کند. تیر پیوند باید عموما از تیر ورق درست شود و در محدوده میان دو بادبند در جان آن سخت کننده قرار 

 گیرد.

ید تبدیل به نیروي برشی در جان تیر شود. این انتقال نیرو باید مستقیما و بدون واسطه بال نیروي محوري بادبند با

  تیر (به صورت خمشی) انجام شود.
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 خمشی قاب سیستم -1-9-3
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 نیروهاي برابر در مقاومت و شده تحمل ساختمانی هايقاب توسط قائم بارهاي آن در که است ايسازه سیستم نوعی

 در خمشی هايقاب با هايسازه و کامل، خمشی هايقاب با هايسازه .شودمی تامین خمشی هايقاب توسط جانبی

 .اند گروه این از پلان، هايقسمت سایر در ساده اتصالات با هايقاب و پلان از قسمتی در یا و پیرامون

 .برد ارک به ویژه یا متوسط ،عمولیم پذیريشکل صورت به توانمی را فولادي و بتنی خمشی هايقاب سیستم، این در

  

  

  
  شکل اتصال گیردار و مفصلی، سه بعدي
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 ترکیبی یا دوگانه سیستم -1-9-4

 :آن در که است ايسازه سیستم نوعی

 .شوندمی تحمل ساختمانی قابهاي توسط عمدتاً قائم بارهايالف) 

 ايمجموعه با همراه شده مهاربندي هايقاب یا برشی دیوارهاي از ايمجموعه توسط جانبی بارهاي برابر در مقاومتب) 

 آن اندرکنش و جانبی سختی به توجه با مجموعه دو از یک هر گیريبرش سهم .گیردمی صورت خمشی هايقاب از

 .شودمی تعیین طبقات، تمام در دو،

  .کنند حملت را ساختمان به وارد جانبی نیروي درصد %25 حداقل قادرند مستقلاً خمشی هايقابپ) 

نیروي زلزله طراحی شوند، و بار دیگر دیوارهاي برشی یا  %100ها یک بار براي باید این نوع ساختمان ETABSدر 

تر شد ملاك تهیه نیروي زلزله طراحی شوند. هر کدام از این دو حالت بحرانی %25قاب خمشی حذف شده و براي 

  هاي اجرایی خواهد بود.نقشه

 
 نسبت به بار توزیع جاي به متر، 30 از کمتر ارتفاع با یا و طبقه هشت از کوتاهتر هايمانساخت در: 1تبصره 

 مجموعه و جانبی بار %100 براي را شده مهاربندي هايقاب یا برشی دیوارهاي توانمی جانبی، باربر عناصر سختی

 .کرد طراحی جانبی بار %30 براي را خمشی هايقاب

 مجاز سیستم این در جانبی باربري براي معمولی فولادي و بتنی خمشی هايقاب کارگیري به: 2 تبصره

 .شد خواهد محسوب ساده ساختمانی قاب نوع از سیستم قاب، نوع این از استفاده صورت در و باشدنمی

 و جز و نشده محسوب دوگانه سیستم نکند، برآورده را پ ردیف الزام سیستمی که صورتی در :3 تبصره

  گردد.اختمانی ساده منظور میس قاب سیستم
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  ها در برابر زلزله: محاسبه ساختمانسوم فصل  -3

  ملاحظات کلی

  باید مطابق با نیروهاي زلزله این فصل تحلیل و طراحی شوند. فولادي و بتنیها تمامی ساختمان

  طراحی شوند. 2800نامه آیین فصل سومباید مطابق با ضوابط  مصالح بناییهاي ولی ساختمان

یشترین بانجام شود و هر عضو باید در برابر  هم در برابر نیروهاي زلزلهو هم در برابر نیروهاي باد حاسبه ساختمان باید م

  طراحی شود. دو نیروحاصل از این  مقدار تنش

  
ادگیر بهاي با وزن سبک و سطح سازهو  هاسولهبحرانی نیست. تنها  هاي معمولیساختمانعموماً نیروي باد براي  نکته:

ها را باید براي نیروهاي باد طراحی کرد و در این سازه ها)برجهاي خنک کننده، دودکش ،هاخراش( مانند آسمان زیاد

  شود.نیروي زلزله بحرانی نخواهد بود. زیرا نیروي زلزله متناسب با جرم ساختمان زیاد می

  

  
  سوله شکل

  در نظر گرفته شود.مولفه قائم زلزله  و هم اثرمولفه افقی زلزله در طراحی باید هم اثر 

 ي افقی: براي طراحی تمامی اعضامولفه -1

قابل  تیرها با بار قائم متمرکزو  متر 15تیرها با دهانه بیش از ، هاها و طرهبالکني قائم: براي طراحی مولفه -2

 توجه

  

 
این زلزله  در اختمان به زمین کوبیده شود.شد سداراي مولفه قائم بسیار بزرگی بود. که عملا باعث می ي بمزلزلهمثلا 

  ي افقی آن بیشتر بود.ي قائم زلزله از مولفهاستثناً مقدار مولفه
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کیلومتري) مقدار شتاب قائم زلزله  5ي کمتر از هستند (فاصله (Near Field) عموما در مناطقی که نزدیک گسل

  ود. در زلزله بم این مورد در خود شهر بم مشاهده شد.زیاد است و ممکن است حتی از مقدار شتاب افقی نیز بیشتر ش

  

    
  شتاب قائم            شتاب افقی

این یک زلزله میدان نزدیک بوده است و شتاب قائم از افقی  _)1383( ي افقی و قائم زلزله بممولفه

  بیشتر است

        
  شتاب قائم            شتاب افقی

این زلزله میدان دور است و شتاب افقی آن از شتاب قائم  _)1391ورزقان (-ي افقی و قائم زلزله اهرمولفه

  بیشتر است

  ولی دو حالت مختلف براي این طراحی وجود دارد: ساختمان باید در دو امتداد عمود بر هم طراحی شود.

در محل تقاطع دو یا چند سیستم باشند که  هاییفاقد ستون وباشند  پلان منظمهایی که در در ساختمان -1

به توان محاس، میقرار دارند (یعنی هر دو شرط باید برآورده شود) (دیوار برشی یا بادبند) باربر جانبی مقاوم

نیروهاي جانبی را براي هر یک از این دو امتداد به صورت جداگانه و بدون در نظر گرفتن نیروي زلزله امتداد 

 دیگر انجام داد.
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 در محل تقاطع دو یا چند سیستمباشند که  هاییداراي ستونو  باشند پلان نامنظمهایی که در در ساختمان -2

قرار دارند (یعنی هر دو شرط باید برآورده شود)، باید محاسبه نیروهاي جانبی را براي هر  مقاوم باربر جانبی

 درصد از نیروي امتداد عمود بر آن 30نیروي زلزله آن امتداد و درصد  100یک از این دو امتداد را تحت اثر 

ستونهاي موجود در محل برخورد دیوار برشی و و همچنین  تمام ستونهاي قاب خمشیداد (یعنی انجام 

  طراحی شوند) 30+100بادبندهاي عمود بر هم باید براي نیروي 
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محوري در ساختمان رعایت شود دیگر احتیاجی به منظور کردن برون 30+100درصورتیکه این ترکیب  :1ي نکته

  .شود)پیچش تصادفی در ساختمان نیست (به این موضوع جلوتر پرداخته میتصادفی و 

  هاي ساختمان باید به صورت رفت و برگشتی لحاظ شود.نیروي زلزله در هر یک از امتداد

  

  نیروي جانبی ناشی از زلزله

  حاسبه کرد.م» دینامیکی«و » استاتیکی معادل«هاي توان با استفاده از روشنیروي ناشی از زلزله را می

  
  :توان در موارد زیر به کار بردفقط میمعادل را  تحلیل استاتیکیروش 

 متر از تراز پایه 50هاي منظم با ارتفاع کمتر ساختمان -1

 متر از تراز پایه 18طبقه و ارتفاع کمتر از  5هاي نامنظم تا ساختمان -2

هاي دو مورد بالا برد. ولی در رابطه با ساختمان توان به کارمی هاکلیه ساختمانرا در مورد  تحلیل دینامیکیروش 

  الزامی نیست.

  روش تحلیل استاتیکی معادل
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م گیریدر این روش نیروهاي زلزله را به صورت نیروهاي افقی در نظر می ترین روش برآورد نیروهاي زلزله است.ساده

  کنند.که به صورت افقی بر تراز طبقات اثر می

      
  

رابطه مشخص است که هرچقدر وزن ن (از ای کنندي ساختمان را تعیین میا نیروي برشی پایهدر این روش ابتد

  .ساختمان بیشتر باشد، نیروي زلزله وارد بر آن بیشتر است)

� = � × � > 0.1 × � × � × � 
 

V باشد. ���0.1 : نیروي برشی تراز پایه که حداقل باید برابر  

W درصدي  هاي ساختمان) ارسازي و وزن دیوهاي سقف، کفر اساس دیتایل(ب : وزن کل ساختمان شامل بار مرده +

  آید)به دست می 2800نامه آیین 1(که از جدول  و بار برف شود)(بر اساس کاربري آن تعیین می از بار زنده

  
  

C  آید:از رابطه زیر به دست میضریب زلزله است و  

� =
���

�
> 0.1�� 

A  طرح: نسبت شتاب مبناي.  

B آید: ضریب بازتاب ساختمان که با استفاده از طیف طرح به دست می.  

I ضریب اهمیت ساختمان :.  

R ه)پذیري ساز(شکل : ضریب رفتار ساختمان.  
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  مجموع وزن طبقات مختلف در ساختمان است. :(W) وزن کل ساختمان

) + نصف وزن دیوارهاي 2800نامه آیین 1تمام بار مرده طبقه + درصدي از بار زنده طبقه (جدول  وزن هر طبقه:

شود. (وزن خرپشته همراه با بام در نظر گرفته می پایین طبقه مورد نظر + نصف وزن دیوارهاي بالاي طبقه مورد نظر

  .توان خرپشته را در مدلسازي به صورت یک طبقه مستقل هم دید)البته می

  
شوند و به محاسبه به صورت خودکار حساب می ETABSنند هاي مهندسی ماافزاروزن طبقات عموماً توسط نرم

  ود.افزار تعریف شدر نرم هاها و دیوارها و پلهواحد سطح کف بارنیست. فقط باید به نحو مناسبی احتیاجی دستی آنها 

 

  تراز پایه

سبت اختمان نحرکتی در ساز آن تراز به پایین  در هنگام وقوع زلزلهکه شود تراز پایه به ترازي در ساختمان اطلاق می

  ).سطح فوقانی شالوده(عموماً  به زمین مشاهده نشود

  
ولی در مواردي که در قسمت اعظم محیط زیرزمین، دیوارهاي حائل مسلح وجود دارد، و این دیوارها با سازه ساختمان 

 اطراف ساختمان در نظر به زمین کوبیده شدهاند، تراز پایه در تراز نزدیکترین کف ساختمان یکپارچه ساخته شده

  وط بر اینکه دیوارهاي حائل تا زیر این کف ادامه داشته باشند.رشود. مشگرفته می
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  (A) نسبت شتاب مبناي طرح

 2800نامه آیین 2بر اساس جدول و خیزي آن نسبت شتاب مبناي طرح در مناطق مختلف کشور بر اساس میزان لرزه

   شود.تعیین می

  است. خیزيچهار منطقه لرزهیران داراي ا

  شود.شتاب مبناي طرح بزرگترین شتابی است که در اثر زلزله به ساختمان وارد می

  شود.در نظر گرفته می (g)به صورت نسبتی از شتاب ثقل شتاب مبناي طرح 

  یابد.ضریب زلزله نیز به همان نسبت افزایش مییابد،  افزایشهرچقدر این شتاب 

    
ین ا چهار قسمت تقسیم شده است. به بندي خطر نسبی زلزله در ایران به صورت زیر است که در آن ایراننقشه پهنه

  توان به دست آورد.نیز می 2800نامه آیین 1بندي را بر اساس پیوست پهنه
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 (B)ضریب بازتاب ساختمان 

  است. ي پاسخ ساختمان به حرکت زمیننحوهضریب بازتاب بیانگر 

  است. داث ساختمانجنس خاك محل احو  تناوب اصلی ساختمانن ضریب تابعی از زمان ای

  شوند:بندي میهاي به صورت زیر طبقهبه طور کلی خاك

 Iخاك نوع   متر 30خاك سخت با ضخامت کمتر از 

 IIخاك نوع   متر 30خاك سخت با ضخامت بیشتر از 

 IIIخاك نوع   خاك با تراکم متوسط

 IVخاك نوع   کم یا خاك رسی با رطوبت زیادخاك با تراکم 

  

  آید:هاي زیر به دست میاین ضریب با استفاده از روابط یا شکل

� = 1 + � �
�

��
�         0 ≤ � ≤ �� 

� = 1 + �         �� ≤ � ≤ �� 

� = (� + 1)× �
��
�
�

�
�
         � ≥ �� 
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T  :تمان استساخ زمان تناوب اصلی نوسان  

اند و بر اساس جداول و نمودارهاي زیر وابسته خیزيمیزان خطر لرزهو  نوع زمینپارامترهایی هستند که به :   �, ��

  شوند.مشخص می

  

 

 (T)زمان تناوب ساختمان 

  .بستگی دارد ارتفاع آن از تراز پایهو  ساختماناي سیستم سازهمشخصات این پارامتر به 

  خمشی فولادي: براي قابهاي

� = 0.08� �/� 
  براي قابهاي خمشی بتنی:

� = 0.07� �/� 
در حرکت جانبی قاب خمشی اختلال ایجاد کنند، در این دیوارهایی باشند که  ،ساختمان يهادرصورتیکه در دهانه

  ضرب کرد. 8/0به دست آمده از رابطه بالا را باید در  Tصورت مقدار 

  
  :دیوارهاي برشی، بادبندي ... )( هابراي دیگر ساختمان

� = 0.05� �/� 
وزن بام  %25در محاسبه ارتفاع در صورتیکه وزن خرپشته از  است. ارتفاع ساختمان بر حسب متر Hدر روابط فوق 

  ثانیه پریود دارد. 1/0هر طبقه تقریبا  بیشتر باشد، باید ارتفاع خرپشته نیز محسوب شود.



39 

 

  
  

مقاطع تیرها حول محور باید ممان اینرسی  ETABSهاي بتنی در برنامه وب ساختماننکته: در محاسبه زمان تنا

  ضرب شود. 5/0قوي در عدد 

Assign > Frame/Line > Frame Property Modifier 
Moment of Inertia about 3 axis = 0.5 

  
  

  ( I )ساختمان  اهمیتضریب 

  شود:می شان به چهار دسته تقسیمها بر اساس اهمیتساختمان

  

 (R)ضریب رفتار ساختمان 

  است. اضافه مقاومت موجود در سازهو  درجه نامعینی، پذیريشکلدهنده عواملی همچون این ضریب نشان

  پذیرتر باشد، مقدار ضریب رفتار بزرگتري دارد.هرچقدر سازه شکل
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ختمان استفاده شود، ضریب رفتار در صورتیکه در ساختمان در یک جهت از دو سیستم باربر جانبی در یک امتداد سا

قسمت تحتانی نباید بیشتر از ضریب رفتار قسمت فوقانی باشد (یعنی نباید سیستم تحتانی ساختمان نرمتر و 

  پذیرتر از سیتم فوقانی باشد).شکل
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حداث ا 2خاك نوع و بر روي  شهر منجیلدر  قاب خمشی بتنی ویژهبا سیستم  طبقه 8اداري مثال: یک ساختمان 

باشد، مقدار برش پایه را در  متر 32تراز پایه است. اگر ارتفاع ساختمان از  تن 1200وزن کل ساختمان شده است. 

  ساختمان به دست آورید.

  حل:

  )5(جدول قرار دارد ضریب اهمیت  3در گروه  )20صفحه -(گروه با اهمیت متوسط ساختمان اداري

� = 1 
بر اساس  2800نامه آیین 1یا پیوست  بندي(نقشه پهنه لی زیاد قرار دارددر منطقه با خطر نسبی خی منجیلشهر 

  )جزوه 2. جدول حروف الفبا شهرها را طبقه بندي کرده است

� = 0.35 
  )6(جدول  قاب خمشی بتنی با شکل پذیري ویژه

� = 10 
  : )3(جدول قرار دارد  خطر نسبی خیلی زیاداست و در منطقه با  2خاك نوع 

�� = 0.1 
�� = 0.5 
� = 1.5 

  آید:به صورت زیر به دست می زمان تناوب آناست بنابراین  قاب خمشی بتنیبا توجه به اینکه ساختمان 

� = 0.07� �/� = 0.07 × 32�.�� = 0.94��� 
  آید:مقدار ضریب بازتاب ساختمان به دست می

� > �� → � = (� + 1)× �
��
�
�
�/�

= (1.5 + 1)× �
0.5

0.94
�
�/�

= 1.64 

  شود:مقدار ضریب زلزله محاسبه می

� =
���

�
=
0.35 × 1.64 × 1

10
= 0.0574 > (0.1�� = 0.1 × 0.35 × 1 = 0.035) 

  آید:مقدار برش پایه ناشی از نیروي زلزله به صورت زیر به دست می

� = � × � = 0.0574× 1200= 69��� 
  

  

ي ترکیبی قاب خمشی ویژه+دیوار برشی بتن مسلح دوگانه طبقه با سیستم 4بیمارستان یک : ساختمان 1 تمرین

تن است. اگر ارتفاع ساختمان  3400احداث شده است. وزن کل ساختمان  4ویژه در شهر رشت و بر روي خاك نوع 

  به دست آورید.متر باشد، مقدار برش پایه را  16از تراز پایه 

  

  

دیوار برشی بتن و  Xمشی بتن مسلح متوسط در جهت طبقه با سیستم قاب خ 6: یک ساختمان مدرسه 2تمرین 

تن  2580احداث شده است. وزن کل ساختمان  1و بر روي خاك نوع  تهراندر شهر  Yمسلح متوسط در جهت 

  به دست آورید. دو جهت متر باشد، مقدار برش پایه را در 24است. اگر ارتفاع ساختمان از تراز پایه 
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  ساختمان توزیع نیروي برشی در ارتفاع

این  ETABSنیروي برش زلزله به دست آمده را باید توسط رابطه زیر در ارتفاع ساختمان توزیع کرد. عموما برنامه 

  باشد.دهد و نیازي به انجام اینکار به صورت دستی نمیرا به صورت خودکار انجام می کار

�� = (� − ��)
��ℎ�

∑ ��ℎ�
�
���

 

ی یابد. ولرویم، مقدار نیروي زلزله وارد به هر طبقه افزایش میزیر هرچقدر به سمت طبقات بالاتر می لشکابق مط

 تر بیشتر از طبقات بالایی است.مقدار برش در طبقات پایین

  : مقدار برش پایه �

  : نیروي شلاقی واقع بر تراز بام یا طبقه آخر ��

  ام i: وزن طبقه  ��

ℎ�  ارتفاع طبقه :i ام از سطح زمین  

  ام i: نیروي زلزله وارد بر طبقه  ��

  
  

  قات ساختمان زیر را به دست آورید.مثال: توزیع نیروي برشی در طب

  
  حل: 

���ℎ� =��ℎ� + ��ℎ� + ��ℎ� = 50× 2.5 + 50 × 5.5 + 30 × 8.5 = 655���.� 
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 �� ℎ� ��ℎ� ���ℎ� V �� �� 

 0 13 655 125 2.5 50  طبقه اول
125

655
× 13 = 2.48��� 

 0 13 655 275 5.5 50 طبقه دوم
275

655
× 13 = 5.45��� 

 0 13 655 255 8.5 30 طبقه سوم
255

655
× 13 = 5.06��� 

 Ton 13 ~ 12.99  مجموع      

 

  یع نیروي برشی در پلان ساختمانتوز

در صورتیکه میان مرکز جرم و مرکز سختی هر طبقه فاصله وجود داشته باشد، به دلیل اینکه نیروي زلزله در مرکز 

روي برشی در هر طبقه، چرخد در نتیجه علاوه بر نیکند ولی کف هر طبقه حول مرکز سختی آن میجرم طبقه اثر می

  آید.زلزله هم به وجود مییچشی ناشی از یک نیروي پ

  
  ها بین آنها توزیع شود. به تناسب سختی بادبندها، دیوارهاي برشی و یا قاب این نیروي پیچشی باید

ف باشد (یعنی سقف تیرچه و بلوك، سق سقف ساختمان صلبالبته شرط به وجود نیروي پیچشی در صورتی است که 

داشته باشیم). ولی در صورتیکه سقف از نوع طاق  مترسانتی 5ل ضخامت دال حداقبا  کامپوزیت یا دال بتن مسلح

ها به قفدر س ی ناشی از زلزلهپیچش برشی و  وي پیچشی در سقف تولید نخواهد شد. توزیع نیرويضربی باشد نیر

  شود.انجام می ETABSصورت خودکار توسط 
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  پذیر (سقف طاق ضربی)سقف انعطاف

       
  ك، سقف کامپوزیت، دال بتنی)ها صلب (تیرچه بلوسقف

  

  اثر برون محوري تصادفی ناشی از زلزله

آیین نامه صراحت دارد در صورتی که حتی مرکز جرم و مرکز سختی ساختمان بر روي یکدیگر قرار داشته باشند، باید 

ده و پیچش بعد ساختمان در جهت عمود بر راستاي زلزله در نظر گرفته ش %5یک برون محوري تصادفی به اندازه 

براي تماي  ETABSرا در برنامه  05/0به این منظور باید ضریب  متناظر با آن محاسبه و به ساختمان اعمال شود.

این ضریب و برون محوري تصادفی باید هم در سمت راست مرکز جرم و هم در سمت چپ  بارهاي زلزله اعمال کرد.

  لحاظ شود. Yو  Xهمچنین باید در هر دو سمت  مرکز جرم وارد شود.
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  محاسبه ساختمان در برابر واژگونی

کل ساختمان باید از نظر واژگونی پایدار باشد. لنگر واژگونی ناشی از نیروي زلزله در تراز شالوده برابر با مجموع 

  به تراز زیر شالوده ساختمان است.حاصلضرب نیروي جانبی هر تراز در ارتفاع آن نسبت 

  
  

  باشد. 75/1واژگونی باید حداقل برابر  ضریب اطمینان در برابر

در محاسبه لنگر مقاوم، بار تعادل برابر بار قائمی است که براي تعیین نیروي جانبی به کار رفته است. بر این بارها وزن 

  ود.ششود. در تراز شالوده این لنگر نسبت به لبه بیرونی شالوده محاسبه میشالوده و خاك روي آن نیز افزوده می

  
  شود:نگر واژگونی به صورت زیر محاسبه میل

��(�����������) =���ℎ�

�

���

 

  : نیروي جانبی هر طبقه  ��

ℎ�  ارتفاع هر طبقه از تراز پایه :  

  شود:لنگر مقاوم نیز به صورت زیر محاسبه می

��(���������) =�����

�

���

+ �� 

  : وزن هر طبقه  ��

  : فاصله وزن طبقه از لبه بیرونی فونداسیون  ��

  : وزن فونداسیون و خاك روي آن �

L فاصله وزن شالوده از لبه بیرونی فونداسیون :  
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  باشد. 75/1نسبت لنگر مقاوم به لنگر واژگونی باید بزرگتر از 

��

��

≥ 1.75 

وجود داشته باشد، مقدار لنگر واژگونی به نسبت قابهاي خمشی بیشتر  دیوار برشی و یا بادبندتمان در صورتیکه در ساخ

 توان طول یا عرض ساختمان را افزایش داد تا لنگر مقاوممیافتد. در این صورت شده و پایداري ساختمان به خطر می

  بیشتر شود.

  
  

  

تن و ارتفاع هر  80منظم، با وزن موثر هر طبقه برابر با  (دو سقف) روي پیلوت طبقهیک مثال: در یک ساختمان 

 5در صورتیکه طول فونداسیون  تن باشد، لنگر واژگونی چقدر است؟ 25متر، اگر برش پایه برابر  3طبقه مساوي 

  ضریب اطمینان در برابر واژگونی را حساب کنید. .باشد تن 20و وزن آن  متر

  
  هر طبقه را حساب کنیم:وي وارد بر در ابتدا باید نیرحل: 

�� = � ×
�� × ℎ�
∑ ��ℎ�
�
���

= 25
80 × 3

80 × 3 + 80 × 6
= 8.34��� 

�� = � ×
�� × ℎ�
∑ ��ℎ�
�
���

= 25
80 × 6

80 × 3 + 80 × 6
= 16.67��� 

  برابر خواهد بود با: (محرك) مقدار لنگر واژگونی

�� = �� × ℎ� + �� × ℎ� = 8.34 × 3 + 16.67 × 6 = 125���.� 
  برابر خواهد بود با: مقاوممقدار لنگر 

�� = 80× 2.5 + 80 × 2.5 + 20 × 2.5 = 450���.� 
 

�.�.=
��

��

=
450

125
= 3.6 ≥ 1.75 
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  مقاوم است. 6/3با ضریب اطمینان  واژگونی رپس ساختمان در براب

  

  

ار نیروهاي زلزله و نیروهاي افقی وزن را بر اساس دستور زیر به دست آورد و سپس توان مقدمی ETABSدر برنامه 

  انجام شود.و محاسبات مربوطه  هقرار داد EXCELآنها را در برنامه 

Display > Show Table > Analysis Result > Building output > Story Shear 
  

Vx  وVy  که باید تبدیل به نیروهاي زلزله شوند. این نیروها باید براي : نیروي برشی زلزله در تراز طبقات هستند

Ex  وEy استخراج شوند. سپس این نیروهاي برشی باید به نیروهاي زلزله در تراز هر طبقه تبدیل شوند  

P .نیروي وزن تمام طبقات بالایی بر روي تراز همان طبقه است که این نیرو نیز باید به وزن هر طبقه تبدیل شود :  

  

  نیروي قائم زلزله:

  نیروي قائم زلزله تنها در موارد زیر باید در تحلیل و طراحی لحاظ شوند:

 متر. 15هاي بیشتر از تیرها با دهانه -1

 
 کنند.تیرهایی که بار قائم متمرکز قابل توجهی را تحمل می -2

 
 شوند.هایی که به صورت کنسول (طره) ساخته میآمدگیها و پیشباکن -3
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  به صورت زیر است: )2و  1موارد تیرهاي بلند و تیرها با بار متمرکز ( وي قائم زلزله برايمقدار نیر

�� = 0.7���� 

بار قائم زلزله هم در جهت بالا  ) به صورت زیر است. در این حالت باید3ها (مورد مقدار نیروي قائم زلزله براي کنسول

  :و هم در جهت پایین در نظر گرفته شود

�� = 1.4���� 

  

  : نیروي قائم زلزله ��

A  وI شتاب مبناي طرح و ضریب اهمیت ساختمان :  

  گویند)هم می» سربار«(به بار زنده  کل بار زنده: بار مرده +  ��

  

 ساخته شده است، مقدار بار مدرسهو در ساختمان یک  تهرانمتري زیر، که در شهر  2/1مثال: در یک تیر طره 

  زلزله قائم وارد بر کنسول را حساب کنید.

  
  حل:

است. پس مقدار بار زلزله  2/1و ساختمان مدرسه داراي ضریب اهمیت  35/0شهر تهران داراي شتاب مبناي طرح 

  شود:قائم وارد بر کنسول به صورت زیر محاسبه می

�� = 1.4���� = 1.4 × 0.35 × 1.2 × (2100+ 1500)= 2117�� �⁄  

  

  

تعریف کرده و سپس مقدار  User Loadرا به صورت  Ezباید ابتدا یک ترکیب بار  ETABSکار در برنامه براي این

شود. محاسبه نمی ETABSاین بار را به اعضاي کنسول اختصاص دهیم. توجه کنید که بار قائم زلزله توسط برنامه 

  .معرفی کنید گذاريدر ترکیبات بار هم به صورت منفیو  مثبت هم به صورترا باید ) ��(همان  Ez دقت کنید که بار
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  ترکیب نیروهاي قائم زلزله با نیروهاي افقی زلزله

یم، (در صورتیکه از این ضابطه استفاده کن بارهاي قائم و افقی زلزله باید به صورت زیر در ترکیبات بارگذاري وارد شوند

  :را در بارهاي زلزله لحاظ کنیم) صادفیمحوري تلازم نیست که اثر بروندیگر 

 نیروي قائم زلزله %30نیروي زلزله در امتداد افقی دیگر +  %30نیروي زلزله در هر امتداد افقی +  100% -1

 نیروي زلزله در هر یک از دو امتداد افقی عمود برهم %30ه در امتداد قائم + نیروي زلزل 100% -2

  صورت زیر خواهند بود:در واقع به صورت خلاصه این دو بند به 

�� + 0.3�� + 0.3�� 

�� + 0.3�� + 0.3�� 

�� + 0.3�� + 0.3�� 

الا با توجه به بند ببنابراین مثلا در یک ساختمان فولادي باید ترکیبات بارگذاري زیر جهت طراحی اعضاي فولادي 

  مل نیستند و ترکیبات دیگري هم لازم است):(البته این ترکیبات بارگذاري کا معرفی شوند

0.75�� + � ± �� ± 0.3�� ± 0.3��� 

0.75�� + � ± �� ± 0.3�� ± 0.3��� 

0.75�� + � ± �� ± 0.3�� ± 0.3��� 

 

  هاي تحلیل دینامیکی = بماند براي ترم بعدروش

 ft)(Dri ساختمانتغییرمکان جانبی نسبی طبقات کنترل 

 سبین پس از تحلیل سازه و قبل از طراحی سازه انجام شود، کنترل تغییرمکان جانبییکی از مهمترین مواردي که باید 

ر هاي مراکز جرم کف طبقات بالا و پایین از یکدیگدر واقع، اختلاف تغییرمکان تغییرمکان نسبی جانبی ساختمان است.

  باشد.می
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  ساختمان باید از رابطه زیر استفاده کنیم: یتغییرمکان جانبی نسببراي کنترل 

Δ� = 0.7RΔ� 
 در این رابطه،

Δ�  در هر طبقه (باید به صورت دستی حساب شود) نسبی واقعی طرح: تغییرمکان جانبی  

Δ�  طبقه (برنامه هر  در  نسبی طرح: تغییرمکان جانبیETABS برنامه )کنداین پارامتر را حساب می .ETABS 

  توسط کاربر در ارتفاع طبقه ضرب شود. Drfitمحاسبه شده و باید مقدار  Driftدهد بلکه مقدار را نمی �Δمقدار 

R ضریب رفتار ساختمان :  

هاي باید با مقادیر زیر مقایسه شوند و در صورتیکه از این مقادیر بیشتر باشند، باید تیرها و ستون �Δسپس مقدار 

  د.ساختمان تقویت شون

 

Δ�  0/025 برابر ارتفاع طبقه   >
  ثانیه 7/0هاي با زمان تناوب کمتر از  براي ساختمان

 هاي مهاربندي و دیوار برشی)(عموما ساختمان

Δ�  0/02 برابر ارتفاع طبقه   >
 7/0هاي با زمان تناوب مساوي یا بیشتر از براي ساختمان

 هاي قاب خمشی)(سیستم

  

تر ذکر شد) و هم توان از روابط تجربی استفاده کرد (که پیشن زمان تناوب ساختمان هم میبراي به دست آورد

  و با استفاده از دستور زیر مقدار پریود مود اول ساختمان را به دست آورد: ETABSتوان از خروجی برنامه می

Display > Show Table > Analysis Result > Modal information > Modal participation 
mass ratio 
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نباید  تغییرمکان نسبی جانبی هر طبقهمتر است، پس مقدار سانتی 300هاي مسکونی عموما ارتفاع طبقات ساختمان

×0.025از  300 =   بیشتر باشد.  ��7.5

مشکلی  دیوار برشی و مهاربنديهاي ولی براي ساختمان .دهدجواب نمی هاي قاب خمشیساختماندر  Driftعموما 

  وجود ندارد. Driftاز بابت 

دهد. به همین جهت باید مقدار (یعنی تغییرمکان جانبی نسبی / ارتفاع طبقه) را می Driftمقدار  ETABSبرنامه 

Drift  را به دست آوریم.» تغییرمکان جانبی نسبی«را در ارتفاع طبقه ضرب کنیم تا بتوانیم مقدار  

����� = 
∆�
ℎ

 

را فقط براي بارهاي  Driftمقدار باید ساختمان را به دست آورد. همچنین  Driftتوان ه از دستور زیر میبا استفاد

EX  وEY (بدون خروج از مرکزیت تصادفی) کرد. محاسبه  

Display > Show Table > Analysis Result > Displacement > Diaphragm Drift 
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 ETABSحاصل از برنامه  Driftپذیري متوسط مقدار بتن آرمه خمشی با شکل طبقه 6 اگر در یک ساختمانمثال: 

را کنترل » تغییرمکان نسبی واقعی طرح«متر باشند، مقدار  3باشد و ارتفاع طبقات نیز  0069/0در طبقه سوم برابر 

  کنید. 

  

  حل: ابتدا باید زمان تناوب ساختمان را به دست آوریم:

� = 0.07� �.�� = 0.07 × (6 × 3)�.�� = 0.61��� 
  آید:به دست می »تغییرمکان نسبی طرح«سپس مقدار 

∆�= ����� × ℎ = 0.0069 × 300�� = 2.07�� 
ري پذیآرمه با شکلآید (براي ساختمان خمشی بتنبه دست می» تغییرمکان نسبی واقعی طرح«سپس مقدار 

  است) : R=7متوسط مقدار 

Δ� = 0.7RΔ� = 0.7 × 7 × 2.07 = 10.143�� 
  ثانیه است، در نتیجه: 61/0با توجه به اینکه تناوب ساختمان برابر 

∆� < 0.025× ℎ  →   10.143 <  (0.025× 300 = 7.5��)     ⊠ 
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ي تیرها در ساختمان رعایت نشده و باید ابعاد و اندازه Driftبا توجه به اینکه این موضوع صادق نیست، پس شرط 

  تقویت شود.ها و ستون
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 هادر تحلیل و طراحی سازه ETABSآموزش 

  یمشخصات پروژه بتن

  سقف کامپوزیت □  دال بتنی □  طاق ضربی □   تیرچه بلوك ■    :  سقف

  اداري □  تجاري □  مسکونی ■    کاربري : 

  رشت     : محل پروژهشهر 

  4نوع ■  3نوع □  2نوع □  1نوع  □    : نوع خاك

  : ايسیستم سازه

  متوسطپذیري با شکلدیوار برشی بتنی  +ب خمشی بتنی قا:  Xجهت 

  پذیري متوسطبا شکل قاب خمشی بتنی : Yجهت 

  مربعکیلوگرم بر سانتی 250:  ستون و سقف-تیر مقاومت بتن

  مربعکیلوگرم بر سانتی 210مقاومت بتن پی : 

  مربعکیلوگرم بر سانتی 4000مقاومت میلگرد طولی : 

  مربعکیلوگرم بر سانتی 3000:  موت)(خا مقاومت میلگرد عرضی
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  توضیحات عمومی -1

  دهد.روي هر آیکونی از برنامه با ماوس اشاره کنید توضیح مختصري راجع به عملکرد آن آیکون نشان می

  
 doubleرا نگه دارید و  Shiftتوانید رو آن باکس مربوطه کلید در هر قسمتی که ماشین حساب احتیاج داشتید می

click .کنید  

  
توان به سه صورت انجام داد. به این صورت که روي یک طبقه، روي طبقات مشابه تغییرات اعمال شده روي مدل را می

  و یا تمام طبقات انجام شود.

  
ها یک باکس از بالا به پایین بکشیم، تمام اعضاي در صورتی براي انتخاب کردن المان AutoCADهمانند برنامه 

شوند. ولی در صورتیکه از پایین به بالا باکس رسم شود، تمام اعضایی که قسمتی از آنها در انتخاب میداخل آن کادر 

  شوند.داخل کادر قرار دارند انتخاب می

  

بعدي، پلان و ارتفاعی هاي سهتواند در حالتتوان استفاده کرد. مدل میبراي بزرگنمایی مدل می Zoomاز دستورات 

 جا شدتوان نماهاي مختلف پلان و ارتفاع جابههاي بالا و پایین میبا استفاده از فلشقرار بگیرد. همچنین 

  
  توانیم مشخصات هندسی و مصالح آنها را مشاهده کنیم.می ،کنیموقتی روي هر عضو کلیک راست می
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  ساخت هندسه مدل -2

  شود. در این مرحله یک ساختمان بتنی مدل می

توانند شوند این است که به خوبی نمیالتحصیل میکه به تازگی از دانشگاه فارغ بزرگترین ضعف مهندسین عمرانی

 ETABSهاي لازم براي مدلسازي در برنامه وروديبه هاي معماري استخراج کرده و اطلاعات لازم را از روي نقشه

  تبدیل کنند.

  معماري مدلسازي، تحلیل و طراحی کنیم. هايکنیم تا از ابتدا یک ساختمان را بر اساس نقشهدر این پروژه تلاش می

این برنامه داراي این قابلیت است که پس از  شود.سازي سازه استفاده میبراي مدل ETABS 2013در این درس از 

  اي را نیز ارائه کند.هاي سازهتحلیل و طراحی دیتایل

  .کنیدو در برنامه وارد  کردهستخراج نها از یکدیگر اآ و فاصله هاتنها کافیست که جاي ستون ي زیرهادر پلان
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  پلان پارکینگ
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  پلان طبقه اول و دوم
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  پلان طبقه سوم
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  برش جانبی
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  برش جانبی ساختماننماي 

  

  سازي قرار گیرد.تار تیرها باید ملاك مدلمیان

نامه اده و آیینقرار د Metric SIدر پنجره باز شده واحدها را بر حسب  .شوداجرا می File>New modelدستور 

  دهیم.قرار می ACI 318-11طراحی را 



62 

 

  
ها) و تراز طبقات پروژه تعریف شود. اینکار ي دهانهها یا همان آکس بندي پلان (فاصلهGrid Lineدر مرحله بعد باید 

  تواند انجام شود:به دو صورت می

Uniform Grid ا این حالت در هیچ ساختمانی بندي داراي فواصل یکنواخت است که عموم: یعنی خطوط آکس

  وجود ندارد.

Custom Spacing ها توسط خود کاربر تعیین خواهد شد.ي آکس: فاصله  

سقف است.  5هاي ساختمان نیز آکس داریم. همچنین تعداد سقف Y 8آکس و در جهت  X 4جهت در این پروژه در 

 customگزینه  سپسپنجره زیر وارد کرده  را در Yو  Xدر جهت  را ها Grid Lineتعداد  ها وپس تعداد سقف

grid spacing را انتخاب کرده وEdit Grid data زنیم.را می  

  
 ،را انتخاب کرده Display Grid Data as Spacingهاي پلان را داریم گزینه به دلیل اینکه فاصله بین آکس

 Lableبراي تنظیم اندازه شعاع دایره در  Bubble sizeکنیم. گزینه ها را مطابق شکل زیر وارد میفاصله میان آکس

  کنیم تا به صفحه قبلی برگردیم.می OKبعد از تنظیم  هر آکس است.
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هاي طبقات با تعداد سقف همان تعداد کف طبقات است نه تعداد طبقات ساختمان. Storyتعداد دقت کنید که 

 Edit storyو سپس  custom story dataرا وارد کرده سپس گزینه  5است. پس تعداد سقف  5احتساب خرپشته 

data هاي اول تا سوم شبیه یکدیگر هستند و کاربري مسکونی دارند در اینجا به دلیل اینکه سقف کنیم.را انتخاب می

هاي اول و دوم را شبیه فانتخاب کرده و سق Master story(بار طبقاتشان یکی است)، پس سقف سوم را به عنوان 

  اند.ها متفاوتکنیم. سقف چهارم و پنجم سقف بام هستند و با این سقفبه طبقه سوم انتخاب می

پایه صفر که در پلان معماري نشان داده  کنیم. دقت شود که ترازماري وارد میارتفاع طبقات را زیر مطابق پلان مع

سازي در معمولا به دلیل کف شود.انی از روي فونداسیون شروع میشده تراز پایه عمرانی نیست و تراز صفر عمر

سانتیمتر زیر تراز صفر ساختمان قرار دارد. همچنین دقت شود که تراز سقف طبقات  40پارکینگ، تراز فونداسیون 

 هباید همان تراز دال بتنی سقف تیرچه بلوك باشد نه تراز کف معماري طبقات، به همین دلیل چون در هر طبق

 12تا  10سرامیک، ملات ماسه سیمان و پوکه ریزي بر روي دالی بتن کف قرار دارد، باید از تراز معماري طبقات 

  فاصله دال بالایی تا دال پایینی است. ETABSدر واقع ارتفاع طبقات در  اي برسیم.متر کم شود تا به تراز سازهسانتی

     
 (cm)اي طبقات تفاع سازهار (cm)اي تراز سازه (cm)تراز معماري   

  310  -40  0  همکف

  320  +270  +280  سقف اول

  320  +590  +600  سقف دوم

  320  +910  +920  سقف سوم
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  310  +1230  +1240  سقف چهارم

  -  +1540  +1550  سقف پنجم

  

 OKرا انخاب کرده و  Grid Onlyبعد حالت  کنیم.می OKپس مشخصات طبقات را مطابق شکل زیر وارد کرده و 

  کنیم.می

  
  درست شود. زیر اي مطابق شکلباید صفحه

  
  .هاي مایل باید مطابق شکل زیر عمل کنیدبراي تعریف ستون بر روي آکس
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  Defineمنوي  -3

 و ... در این رمج، مرکز بار، انواع بارگذاري، ترکیبات مقاطعابعاد ، مصالحتمامی مشخصات ساختمان اعم از مشخصات 

است و تا انتهاي پروژه نیز با همین واحد  kg-cmتوجه به اینکه مشخصات مصالح ما در واحد شود. با منو مشخص می

سر و کار داریم، پس بهتر است واحدها را در کل مدل به این صورت تغییر دهیم. در گوشه پایین سمت راست مدل 

  دهیم.ها را تغییر میمطابق پنجره زیر واحد consistent unitsکلیک کرده و با انتخاب  unitروي دستور 

  
  

3-1-  Material Properties  
در این دستور مشخصات از پیش  شود.تعریف می Define/Material Propertiesمشخصات مصالح توسط دستور 

تعریف شده وجود دارد. ولی با توجه به اینکه مشخصات مصالح موجود براي کشورهاي دیگر است بنابراین ما باید 

سپس در حالت  اجرا شود. Add New materialمان تعریف کنیم. بنابراین باید دستور مشخصات مصالح را خود

User  مصالحConcrete کنیم.را انتخاب می  

      
  مشخصات مصالح بتنی -3-1-1

استفاده کرد. در این رابطه باید مقدار مقاومت فشاري  ACIتوان از رابطه براي به دست آوردن مدول الاستیک بتن می

(fc) حسب  بتن بر(Kg/cm2) .15ي نمونه استوانه استاندارد بتن با ابعاد روزه 28در این رابطه باید مقاومت  باشد 

  متر جاگذاري شود.سانتی 30در 
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� = 15100���
� = 15100× √250 = 238752�� ���⁄  

�به صورت  مبحث نه مقررات ملی ساختماننامه این رابطه براي آیین = 5000���
است که در این صورت مقدار  �

 (Kg/cm2)متر مربع کیلوگرم بر سانتی 9.81هر یک مگاپاسکال  وارد شود. Mpaمقاومت فشاري بتن باید برحسب 

 مقاومت فشاري است. 0.2ضریب پواسون بتن  مگاپاسکال است. 25متر مربع تقریبا کیلوگرم بر سانتی 250است. یعنی 

�� روزه 28اندارد بتن اي استي استوانهنمونه
مقاومت تسلیم فولاد میلگرد  متر مربع است.کیلوگرم بر سانتی 250برابر  �

 مقاومت تسلیم فولاد میلگرد خاموت است. )AIII(میلگرد  متر مربعکیلوگرم بر سانتی 4000برابر  fy (Rebar) طولی

(Stirrup) fys  رد (میلگ متر مربعکیلوگرم بر سانتی 3000برابرAII( .مشخصات مصالح را مطابق شکل زیر  است

  تکمیل کنید.

     
به همان صورت قبلی دو مصالح به را هم تعریف کرد. پس   (Stirrup)ها و خاموت (Rebar) باید مشخصات میلگرد

  کنیم.تعریف می barاین اسامی و با نوع 
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  )(براي مقاطع نورد شده فولادي مشخصات مصالح فولادي -3-1-2

مقدار مدول الاستیک فولاد  وارد شود.کیلوگرم بر مترمربع  7850و  800مقدار جرم و وزن فولاد باید به ترتیب 
 2400به ترتیب  ST37براي فولاد  Fu و تنش نهایی Fy مقدار تنش تسلیم است.مربع کیلوگرم بر سانتی 10×62.1

  است. 3/0 ضریب پواسون آن .متر مربع استکیلوگرم بر سانتی 3700و 
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3-2- Frame Section  

در مورد  مقررات ملی مبحث نهمبر اساس شود. ها بر اساس این دستور تعریف میمشخصات مقاطع تیرها و ستون

  :هاي زیر رعایت شودمقاطع بتنی باید محدودیت

  :مقطع تیرهاي محدودیت

 ).داشته باشیم تیر عمیقنباید (باشد  (بر تا بر ستون) طول آزاد دهانه 4/1ارتفاع مقطع نباید بیشتر از  

داشته باشیم تا از کمانش جانبی  تیر با مقطع لاغرنباید باشد ( عارتفاع مقط 4/1عرض مقطع نباید کمتر از  

 ).تیر جلوگیري شود

 متر باشد.سانتی 25عرض مقطع نباید کمتر از  

 متر بیشتر شود.سانتی 50از  تواندمتر باشد ارتفاع مقطع تیر نمیسانتی 200مثلا اگر طول آزاد دهانه 
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  متر کمتر شود.سانتی 10تواند از متر باشد، عرض مقطع تیر نمیسانتی 40اگر ارتفاع مقطع تیر 

     
  هاي مقطع ستون:محدودیت

 ارتفاع تیر باشد (مقطع ستون لاغر). 3/0مقطع ستون نباید کمتر از عرض  

 .متر باشدسانتی 25عرض مقطع ستون نباید کمتر از  

  بیشتر باشد (ستون لاغر). 25نسبت طول آزاد دهانه ستون به عرض مقطع نباید از  

توان مقاطع را کنیم. میاجراي می Define>Section properties>Frame Sectionبراي تعریف مقطع دستور 

  کنیم.می Importیک منبع دیگر آنها را به برنامه یا اینکه آنها از  (Add) درست کرد

  
  تعریف کرد: ETABSتوان در مقاطعی که میانواع 

 I/wide flange پهن: مقاطع بال 

 Channel مقاطع ناودانی : 

 Tee مقاطع سپري : 

 Angle نبشی : 

 Double Angle مقاطع دوبل نبشی : 

 Boxمقاطع مربع توخالی : 

 Pipeمقطع لوله : 

 Rectangular مقطع مربع مستطیل توپر : 

 General نها در : مقاطعی که شکل آETABS  تعریف نشده است و باید مشخصات هندسی آنها را به

 داد. ETABSصورت دستی به 

 Autoselect دهد.ترین مقطع را از یک تعداد مقطع تعریف شده به اعضا اختصاص مینهیه: ب 
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 Section Designer یک ستون که از دو پروفیل مثلا  کند.ست میر: یک مقطعی را خود کاربر دI شکل 

ین توان توسط اتقویت تشکیل شده است و یا یک دیوار برشی بتنی با میلگردهاي آن را می Plateو چهار 

 دستور ایجاد کرد.

    
ها استفاده که عموما در تیر و ستون سوله: همان مقاطع غیر منشوري هستند.  Nonprismaticمقاطع  

 شوند.می

     
ها انتخاب تیرهاي اجرایی که بر محدودیت زنیم.سه مقطع براي تیر حدس میو  سازي سه مقطع براي ستونبراي مدل

  ها حاکم است:و ستون

  .بندي)ن طبقه یکی باشد (به دلیل مسائل قالبآعرض تیر هر طبقه باید با بعد ستون  

 .کند)(فقط مقدار آرماتور در هر طبقه تغییر می همچنین مقطع ستون ها باید در هر طبقه یکی باشد 

ها در نظر بگیریم، حالت اول این است که فقط ابعاد مقطع را توان براي طراحی ستوندو حالت می ETABSر د

در حالت دوم هم ابعاد مقطع و هم تعداد و قطر . کندمحاسبه میمقدار میلگرد مورد نیاز را  ETABSبدهیم و 

  کند. کفایت مقطع را بررسی می ETABSدهیم و میلگردها را می

سطح مقطع ستون  %6بیشتر از و  %1کمتر از ها نسبت آرماتور طولی نباید در ستون ها:یت آرماتور ستونمحدود

حداکثر  مترسانتی 50×50ستون یابد. مثلا در کاهش می %3ها به باشد که این محدودیت با در نظر گرفتن وصله ستون

  توان استفاده کرد:می 22عدد میلگرد  20از توان می

�(20�22)= 76���  

  =  درصد میلگرد ستون
��

��×��
= 0.0304 = 3.04%  ≅ 3% 

تعریف  ETABSمیلگرد ستون را در  %3ها یعنی نزدیک به میلگردهاي ستون ممکن در این پروژه ما حداکثر مقدار

باید ابعاد  ها را بررسی کند. در صورتی که این مقدار میلگرد جواب ندادکفایت مقاطع ستون ETABSکنیم تا می

ها باید یکنواخت در پیرامون آن چیده شود، به مقطع ستون را افزایش داد. دقت کنید به دلیل اینکه میلگرد ستون

در هر طبقه  نیز هامقطع ستون و ....). 20یا  16یا  12یا  8یا  4باشد (مثلا  4همین دلیل تعداد آنها باید مضربی از 

  .بندي)(به خاطر مسائل قالبدهیم میور را تغییر یکی باشد و فقط مقدار آرماتباید 
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لازم نیست میلگردهاي فوقانی و تحتانی تعریف شوند، تنها کافی است که ابعاد مقطع وارد شود و خود  براي تیرها

ETABS ها حدس مقاطعی که براي تیرها و ستونکند. مقدار مساحت میلگردهاي فوقانی و تحتانی را محاسبه می

  زنیم:می

  درصد میلگرد ستون  میلگرد ستون  ستون  تیر  

 2.54 16�18  40×40 40×40  سقف اول

  2.49 12�18  35×35  35×35  سقف دوم و سوم

  2.68 12�16  30×30  30×30  و خرپشته سقف چهارم

  

ید عرض باشد با 40بندي. مثلا اگر بعد ستون نکته: عموماً عرض تیر و بعد ستون باید یکی باشند به دلیل مسائل قالب

  بیشتر یا کمتر باشد. 40تواند از ل به ستون میصباشد ولی عمق تیر مت 40تیر هم 

  
  

بهتر کنیم. را انتخاب می Add new propertyگزینه  Click toبراي اینکه مقاطع بتنی را درست کنیم از منوي 

ر ابتداي نام مقطع استفاده د B (Beam)حرف از  تیرو براي مقاطع  C (Column) از حرف ستونمقاطع است براي 

  کنیم.را انتخاب می Concrete Rectangularشود. نوع 
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هاي بتنی باید ممان اینرسی خوردگی مقاطع بتنی این است که براي تحلیل سازهدر مورد ترك 2800نامه ضابطه آیین

ضرب شود. اینکار توسط  0.35ضرب شود و ممان اینرسی تیرها حول محور قوي در  0.7ها در هر دو جهت در ستون

  شود.انجام می modify/show modifierدستور 

  
را اجرا کنید. در  Modify/Show rebarدستور  ها تعریف شود.مقطع ستونپس از آن باید میلگردهاي موجود در 

دهاي طولی و (طراحی براي ستون) انتخاب کنید. نوع میلگر P-M2-M3پنجره زیر باید اولا نوع طراحی را از نوع 

 Reinforcementنوع طراحی را از نوع  قرار دهید. Stirrupو  Rebarخاموت را که قبلا تعریف شده بود باید از نوع 

to be checked ها در هر کدام دهیم تا فقط کفایت میلگردها کنترل شود. تعداد و اندازه میلگردها و خاموتقرار می

  شود.تعیین می 3و  2از جهات 

مقررات  9نامه مبحث براي مقاطع بتنی بر حسب شرایط محیطی باید تعریف شود. این مقدار در آیین coverمقدار 

معمولا حداقل کاور را  است. خاموت ، مقدار ضخامت بتن تا روي میلگردcoverملی ساختمان آمده است. منظور از 

  گیرند.متر در نظر میسانتی 5/4
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  این است که: باید توجه کردها گذاري و میلگردگذاري تیرها و ستوناموتکاتی که در رابطه با خن

  تر بیشتر باشد.مسانتی 15آزاد میان میلگردها نباید از فاصله  

به جز ( خاموتها باید به نحوي قرار بگیرند که بیشتر از یک میلگرد آزاد بین دو میلگرد وجود نداشته باشد 

  .میلگرد گوشه)

  میلیمتر کمتر باشد. 6باید از وت نمقطر میلگرد خا 

  متر بیشتر باشد.سانتی 25فاصله دو خاموت نباید از  

 کنند.هاي معمولی استفاده میبراي خاموت در سازه 10و  8معمولا از میلگردها  

  
  

  
  .وجود دارد Show Section propertiesمشخصات مقاطع در دستور 
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 استفاده کرد.  Add Copy of Propetiesبراي تعریف مقاطع دیگر می توانید از دستور 

  . Rebarو  Modifierهاي در قسمت براي تعریف مقطع تیرها دو تفاوت وجود دارد
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  تعریف دال کف -3-3

طرفه و دوطرفه. در سقف یکطرفه بار کف روي دو تیر روبروي دو نوع سقف به لحاظ توزیع بار وجود دارد، سقف یک

بار به صورت متقارن و در در نظر گرفتن نیمسازهاي هر کنج میان چهار تیر  طرفهشود ولی در کف دوهم منتقل می

هاي دوطرفه از نوع سقف که داراي مش میلگرد در دو جهت باشند، شود. دالهاي بتن مسلحمتصل به دال توزیع می

ربی از نوع . ولی سقف تیرچه بلوك، سقف کامپوزیت و سقف طاق ضمدل شوند SLABو باید توسط المان  هستند

  .مدلسازي شوند DECKو باید توسط المان  دال یک طرفه هستند

  
سپس دستور  .شودتعریف می Define>Section properties>Deck Sections نوع سقف توسط دستور

Modify/Show property کنیم. نوع را اجرا میDeck  را از نوعFilled  قرار داده و باقی مشخصات آنرا مطابق

  )هاي بارگذاري مشخص شود.Detailباید قبل از این  (به بارگذاري ربط داردکنیم. ظیم میشکل تن
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کنیم. ولی بارگذاري این با همان مشخصات تعریف می Deck2یک سقف به نام  و خرپشته نیز راي بارگذاري بامب

  هاي طبقات پایین است.سقف نیز متفاوت با سقف

  
  

  تعریف دیوار برشی -3-4



77 

 

توزیع دیوارهاي برشی در  شود.استفاده می  Wallیف دیوار برشی و دیوار حائل از المان براي تعر

الامکان متقارن باشد تا در اثر بار زلزله در ساختمان پیچش به وجود نیاید. بهتر است دیوارها در ساختمان باید حتی

  هاي ساختمان قرار گیرند و در مرکز ساختمان واقع نشوند.کناره

  
  گیریم:در نظر می اولیه دیوارهایی با ضخامت زیر رایک فرض براي 

  ضخامت دیوار برشی  

  (W30)متر سانتی 30 طبقه اول

  (W25)متر سانتی 25 طبقه دوم و سوم

  (W20)متر سانتی 20 طبقه چهارم

  

 2800نامه نآیی 6-5-2مطابق بند شود. تعریف می Define>Wall/Slab/Deck Sectionنوع دیوار توسط دستور 

را  f22و  f11 در یک حالت دست بالا ما باشد. 7/0تا  35/0خورده دیوارها باید به اندازه ممان اینرسی مقطع ترك

  گذاریم.می 0.35اصلاح کرده و 
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  دیافراگم -3-5

هاي مختلف گونه تغییرمکان جانبی نسبی میان گرهکف بسیار صلبی است که در اثر نیروهاي افقی زلزله هیچ ،دیافراگم

اي ها و دیوارهشود که نیروهاي زلزله به صورت یکنواخت میان تیرها، ستونآید. این خاصیت باعث میآن به وجود نمی

دیافراگم  باشد به عنوان مترسانتی 5ضخامتشان بیشتر از هایی که دال 2800نامه آیینبرشی توزیع شوند. بر اساس 

هاي متر و سقفسانتی 5بتنی، سقف تیرچه بلوك با ضخامت دال بیشتر از  دال تختشوند، یعنی در نظر گرفته می

دیافراگم  بامهاي خرپاي چوبی پشتهاي طاق ضربی و سقفمتر. سقفسانتی 5ز کامپوزیت با ضخامت دال بیشتر ا

افراگم ید لحاظ شود. در آن دیافراگم تعریف شود باید اثرات پیچش تصادفیسقف به صورت نیستند. در صورتیکه 

  باشد. Rigidنوع دیافراگم باید از نوع  شود.تعریف می Define>Diaphragmsتوسط دستور 
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  سقف تیرچه بلوك (سقف صلب)  پذیر)سقف طاق ضربی (انعطاف

هاي فولادي سقف را توسط میلگردهاي ضربدري به هم ضربی را بالا ببریم، تیرچهبراي اینکه صلبیت سقف طاق

  کند.یم. در این حالت سقف تا حدودي صلبیت لازم را تامین میبندمی

  
3-6- Pier Label  

  

 (Laod Pattern)الگوهاي بارگذاري  -3-7

شود. این بارها باید توسط دستور بارهاي مختلفی ازجمله بار مرده، زنده، باد، برف و زلزله بر ساختمان وارد می

Define>Load pattern .کند که براي تصریح می 2800نامه آیین 3-10-3-2در بند  به برنامه معرفی شوند

درصد بعد ساختمان در آن طبقه در امتداد عمود بر  5به اندازه حداقل » مرکزي تصادفیبرون«نیروهاي زلزله باید اثر 

 متر باشد، نیازي به در نظر گرفتن پیچش 18تر از طبقه یا کوتاه 5نیروي جانبی اختیار شود. در صورتیکه ساختمان 

بعد ساختمان در جهت عمود بر زلزله اختیار شود. مقدار این  %5محوري تصادفی باید به میزان تصادفی نیست. برون

 ,EXP)تواند مثبت یا منفی باشد. پس چهار حالت بار زلزله با خروج از مرکزیت خواهیم داشت محوري میبرون

EXN, EYP, EYN) همچنین سه بار بدون خروج از مرکزي .Y, EZEX, E گیریم. بار قائم را هم در نظر می

  .ها وارد خواهیم کردکنیم و مقدار این بار را روي بالکنتعریف می User Loadزلزله را نیز به صورت 

  بارهایی که باید براي تحلیل به برنامه معرفی شوند به صورت زیر می باشند: 

  

  

  توضیح (Type)نوع بار   اسم بار
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Dead  Dead  

باشد. هاي ساختمان میمل وزن دیوارها، کف طبقات، تیرها و ستونبار مرده شا

برابر یک وارد شود تا  Self Weight Multiplierباید عبارت  Deadبراي بار 

وزن تیر و ستون و سقف ساختمان بر اساس حجم و وزن مخصوص آنها در برنامه 

  شود.حساب شده و به سازه اعمال می

Live  Live  
ها وزن اجزاي داخل ساختمان مانند وسائل و تجهیزات و انسانبار زنده شامل 

  باشد.می

EX  Seismic   جهت بار زلزله درX بدون خروج از مرکزي  

EY  Seismic   جهت بار زلزله درY بدون خروج از مرکزي  

EZ  Seismic   جهت بار زلزله درZ بدون خروج از مرکزي  

EXP Seismic   جهت بار زلزله درX ز مرکزیت مثبتبا خروج ا  

EXN Seismic   جهت بار زلزله درX با خروج از مرکزیت منفی  

EYP Seismic   جهت بار زلزله درY با خروج از مرکزیت مثبت  

EYN Seismic   جهت بار زلزله درY با خروج از مرکزیت منفی  

WALL Other  

ود شباري است که براي اصلاح مرکز جرم ساختمان فقط در سقف آخر معرفی می

یعنی به اندازه نصف ارتفاع دیوار شود. و در هیچ یک از ترکیبات طراحی وارد نمی

  کنیم.وارد می Wallطبقه آخر روي سقف بام نیروي 

  

  

  
  محاسبه نیروهاي زلزله براي ساختمان

  )5ضریب اهمیت قرار دارد (جدول  3(گروه با اهمیت متوسط) در گروه  مسکونیساختمان 

� = 1 
  بندي)منطقه با خطر نسبی زیاد قرار دارد (نقشه پهنهدر  رشتشهر 

� = 0.3 
و قاب خمشی بتنی با شکل پذیري متوسط  Xمتوسط در جهت  پذیريبا شکل +دیوار برشی بتنیقاب خمشی بتنی

  )6(جدول   Yدر جهت 

�� = 8 ,  �� = 7 
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  ) :3است و در منطقه با خطر نسبی زیاد قرار دارد (جدول  4خاك نوع 

�� = 0.15 , �� = 1.0 , � = 1.75 
وب آن به صورت است بنابراین زمان تنا قاب خمشی Yدیوار برشی و در جهت  Xدر جهت  با توجه به اینکه ساختمان

بام کمتر از نسبت مساحت خرپشته به مساحت پشت ،2800نامه با توجه به اینکه مطابق آیین .آیدزیر به دست می

ف همچنین به سق شود نه سقف خرپشته.ساختمان بر اساس سقف طبقه آخر محاسبه میتفاع است، بنابراین ار 25%

  شود.هم نیروي زلزله وارد نمی Story5خرپشته یعنی 

� = 12.3� 

�� = 0.05�
�
� = 0.05 × 12.3�.�� = 0.328��� 

�� = 0.07� �/� = 0.07 × 12.3�.�� = 0.46��� 
  آید:بازتاب ساختمان به دست میمقدار ضریب 

�� < �� < �� → �� = (� + 1)= (1.75 + 1)= 2.75 
�� < �� < �� → �� = (� + 1)= (1.75 + 1)= 2.75 

  شود:مقدار ضریب زلزله محاسبه می

�� =
����

��
=
0.3 × 2.75 × 1

8
= 0.103 > (0.1�� = 0.1 × 0.3 × 1 = 0.03) 

�� =
����

��
=
0.3 × 2.75 × 1

7
= 0.118 > (0.1�� = 0.1 × 0.3 × 1 = 0.03) 

لف اي کشورهاي مختنامه بارگذاري لرزهلزله است. آیین، مربوط به بارگذاري زمهمترین تعریف بارگذاري این قسمتدر 

کنند. متاسفانه توانند به صورت کاملا خودکار نیروهاي زلزله را محاسبه اند که میتعریف شده ETABSدر برنامه 

تعریف نشده است و ما باید مقدار نیروهاي زلزله را به صورت دستی به برنامه  ETABSدر  2800نامه بارگذاري آیین

و نیروهاي قائم زلزله (در این مورد جلوتر توضیح  Cکار نیروهاي افقی زلزله توسط ضریب زلزله اعمال کنیم. براي این

  شوند.واحد سطح به مدل اعمال میشود) به صورت نیرو بر داده می

  
وزیع شوند که ابتدا باید محاسبه کنیم که در ساختمان نیروي شلاقی تبه این صورت زیر نیروهاي زلزله در طبقات باید 

ه این شود بوجود دارد یا خیر؟ نیروي شلاقی نیرویی است که در طبقه آخر علاوه بر نیروهاي زلزله توزیع شده وارد می

 7/0با توجه به اینکه زمان تناوب ساختمان در دو جهت از  ثانیه باشد. 7/0مان تناوب ساختمان بیشتر از زشرط که 

  توان حذف کرد.کمتر است پس نیروي شلاقی را می

�� = 0.07�� < 0.25� =   0 
اي اینکار هر هایی و به چه صورت اعمال کند. بربگوییم که بار زلزله را در چه جهت ETABSپس از آن باید به 

Laod Pattern  را انتخاب کرده و دکمهModify Lateral load دهیم. در قسمت را فشار میStory range 
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اعمال  Story 5یعنی  خرپشتهشود ولی بر وارد می Story 4تا  Story1 گوییم که نیروي زلزله بر تمام طبقاتمی

  .نخواهد شد

EX 

  

EY  

  

EXP  

  

EXN  
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EYP  

  

EYN  

  
این مورد  هاي مختلف لحاظ کنید.هاي متفاوتی را براي سقفمحوريتوانید برونمی Overwriteبا استفاده از دستور 

  معمولا چندان کاربرد ندارد.

  
 (Load Combination)بارگذاري  تترکیبا -3-8

یکدیگر ترکیب شده و ، بارهاي مرده، زنده و زلزله باید به صورت مناسب و با ضرایب مشخص با هابراي طراحی سازه

نامه شود. هر آیینانجام می ETABSدر  Load Combinationبراي طراحی سازه به کار روند. این کار توسط 

هاي آمریکا با هند و همچنین ژاپن متفاوت نامهبه خود دارد. مثلا ترکیبات بارگذاري آیین مخصوصترکیبات بارگذاري 

 Define>Loadنیز با هم متفاوت است. این کار توسط دستور  و بتن همچنین ترکیبات بار طراحی فولاداست. 

Combination  به برنامهETABS شود.معرفی می  

  بتنیترکیبات بارگذاري براي ساختمان  -3-9

  اند.به دست آمده 2800نامه این ترکیبات از مجموع چند بند در داخل آیین

وهاي افقی و قائم زلزله باید به صورت زیر با هم کند که نیرتصریح می 3-12-3-2در بند  2800نامه آیین 

  ترکیب شوند:

 نیروي زلزله قائم %30نیروي زلزله در امتداد افقی عمود بر آن +  %30نیروي زلزله در هر امتداد افقی +  100%
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 قائم نیروي زلزله %100نیروي زلزله در امتداد افقی عمود بر آن +  %30نیروي زلزله در هر امتداد افقی +  30%

توان منظور کرد. (در مواردي که را می 2800نامه آیین 4-1-2بند  2در ترکیبات مذکور ضابطه تبصره  

درصد نیروي زلزله در امتداد عمود بر آن در نظر گرفته  30نیروي زلزله در هر امتداد با  %100ترکیب 

 %30اي که در امتداد مربوط به براي نیروي زلزله 10-3-2مرکزي اتفاقی بند شود، منظور کردن برونمی

  شود الزامی نیست.)اعمال می

(به خاطر در  ضرب خواهد شد 0.75در هر ترکیب باري که نیروي زلزله وارد شود، آن ترکیب بار در عدد  

 .اي و اثرات اضافه مقاومت آن)نظر گرفتن اثرات میرایی سازه تحت بارگذاري لرزه

ار باید یک بار با احتساب ب ،د، براي در نظر گرفتن اثرات کاهش بار زندهدر ترکیباتی که بار زلزله وجود دار 

 را لحاظ نمود. زلزله زنده و یک بار بدون احتساب آن ترکیبات بار

  به صورت زیر خواهد بود: ACI-89نامه ترکیبات بارگذاري بر اساس آیین  

1.4� + 1.7� 
0.75(1.4� + 1.7� ± 1.87��� ± 0.3 × 1.87�� ± 0.3 × 1.87��) 
0.75(1.4� + 1.7� ± 1.87��� ± 0.3 × 1.87�� ± 0.3 × 1.87��) 
0.75(1.4� + 1.7� ± 1.87��� ± 0.3 × 1.87�� ± 0.3 × 1.87��) 
0.75(1.4� + 1.7� ± 1.87��� ± 0.3 × 1.87�� ± 0.3 × 1.87��) 
0.75(1.4� + 1.7� ± 0.3 × 1.87�� ± 0.3 × 1.87�� ± 1.87��) 
0.9� ± 1.43��� ± 0.43�� ± 0.43�� 
0.9� ± 1.43��� ± 0.43�� ± 0.43�� 
0.9� ± 1.43��� ± 0.43�� ± 0.43�� 
0.9� ± 1.43��� ± 0.43�� ± 0.43�� 
0.9� ± 0.43�� ± 0.43�� ± 1.43�� 

شوند. می یب بارترک یکیهشتاد و درصورتیکه این ترکیبات بار با علامتهاي مثبت و منفی بسط پیدا کنند تبدیل به 

توان به صورت دستی به برنامه داد که کار بسیار طاقت فرسایی است. یک نمونه از آن به صورت بار را می این ترکیبات

را فشار دهید. در  Add New Comboرا اجرا کنید. دکمه  Define>Load Combinationدستور زیر است. 

کنید و  Addخواهید را انتخاب کرده و بارهایی را که می Linear Addحالت  Combination Typeقسمت 

بار تکرار کنید تا تمام ترکیبات بار وارد شوند. کار خسته  81ضریبشان را در جلویشان قرار دهید. این کار را باید براي 

 پس چه کار باید کرد؟ اي است؟کننده
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ا در لینک زیر قرار دادم این ترکیبات بار رکنید.  Importراه چاره این است: یک بار اینها را تعریف کنید و به برنامه 

م. اینو گري بهتون یاد بدرسیم که یک عدد فوت کوزهتا بتوانید دانلود کنید و در برنامه وارد کنید. خوب به اینجا می

  دن:هر جایی یاد نمی

و دیگري با  ET$سازد. یکی با پسوند دو عدد فایل می ETABSشود، برنامه که ساخته می ETABSهر پروژه 

باز   texteditorرو میشه با  ET$باز کرد. ولی فایل  text editorرو نمیشه خوند و با  EDB. فایل EDBپسوند 

شوند مانند ترکیبات ذخیره می TXTکنیم به صورت تعریف می ETABSتمام مواردي که در  ET$کرد. در فایل 

شود. کاري که ما باید ذخیره میTXT شود در این فایل به صورتبار، یعنی هر آنچه که به صورت گرافیکی انجام می

 تهیه کنیم و در فایل TXTترکیبات بار را به صورت رو ببندیم. بعد  ETABSکه ابتدا فایل  انجام دهیم این است

$ET  کنیم و کپیSave .بعد دوباره این فایل را از منوي  کنیمFile>Import>Etabs .e2k text file  لود

  امه ظاهر شوند.کنیم تا ترکیبات بار در برن

  
  :خواهد بودرا باز کنید به صورت زیر  ET$که فایل در صورتی
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 Load Combination $را از لینک زیر دانلود کنید و محتواي آنرا در قسمت  Concrete-Comboحال فایل 

  جایگزین کنید.

http://seismic.persiangig.com/IAURasht/Combo_Concrete_ETABS2013.txt 

  
را اجرا کنید  File > Import > ETABS .e2k text fileرا باز کنید و دستور  ETABSاز دوباره برنامه بعد 

را که اصلاح کرده بودیم به برنامه بدهید. در صورتی که مدل به درستی ساخته شده باشد،  ET$و مسیر فایل 

  شده را ببینید: ترکیبات بار وارد Define>Laod Combinationتوانیم از طریق دستور می
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  ترکیبات بارگذاري براي ساختمان فولادي -3-10

زیر  توانید از لینکباشد که فایل آنها را نیز میهاي فولادي نیز به شرح زیر میبراي ساختمان ترکیبات بارگذاري

  دانلود کنید:

http://seismic.persiangig.com/IAURasht/Combo_Steel_ETABS2013.txt 
� + � 
0.75(� + � ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� + � ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� + � ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� + � ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� + � ± 0.3 × �� ± 0.3 × �� ± ��) 
0.75(� ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� ± ��� ± 0.3 × �� ± 0.3 × ��) 
0.75(� ± 0.3 × �� ± 0.3 × �� ± ��) 

  منحنی پوش لنگر و برش -3-10-3

قابلیت این را دارد  ETABSگاهی اوقات احتیاج به منحنی پوش لنگر و برش داریم (مخصوصا براي طراحی دستی). 

درست کنیم و  ENVEجدید به نام  COMBOت یک که منحنی پوش را به صورت ایجاد کند. براي اینکار کافیس

را  Combination typeترکیب بار) را با ضریب یک در آن اضافه کنیم. فقط باید گزینه  82تمام ترکیبات بار (هر 

  بگذاریم. Envelopeبه صورت 
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  مرکز محاسبه مرکز جرم ساختمان -3-11

ETABS  ور کار باید دستصورت خودکار محاسبه کند. براي اینداراي این قابلیت است که مرکز جرم ساختمان را به

Define > Mass Source  .در 2800نامه یینشماره آ 1جدول بر اساس را اجرا کرده و تنظیمات زیر انجام شود 

به همین دلیل ضریب  ترکیب شوند. مردهبارهاي  %100با  زندهبارهاي  %20باید  مسکونی محاسبه مرکز جرم ساختمان

 %40اگر ساختمان مدرسه باشد، باید ضریب بار زنده متناسب با کاربري آن یعنی ( شود.در نظر گرفته می 0.2 بار زنده

  در نظر گرفته شود).

باید نصف جرم دیوارهاي پایین و نصف جرم دیوارهاي بالا صراحت دارد که در محاسبه جرم هر طبقه  2800نامه آیین

شود و تنها در طبقه بام و خرپشته رعایت نشده است. بنابراین براي عایت میحساب شوند. این مورد در تمام طبقات ر

 WALLرا تعریف کرده و به اندازه وزن نصف ارتفاع دیوار طبقه آخر بار  WALLاینکه مرکز جرم بام اصلاح شود، بار 

شود و در ترکیبات طراحی این بار فقط در محاسبات مرکز جرم وارد میکنیم. را به تیرهاي بام و خرپشته اعمال می

  سازه نقشی ندارد.

      
  

  P-Delta اثرات -3-12

انجام دهیم تا  Delta-Pها را به صورت ستون کوتاه طراحی کنیم، باید آنالیز براي اینکه ستون هاي بتنیسازهدر 

 Define > P-Deltaاثرات اندرکنش خیز و لنگر در محاسبات آورده شود. تنظیمات این تحلیل بر اساس دستور 

Option گیرد.انجام می  
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  اي، ترسیم اعضاي سازهDrawمنوي  -4

و نوار ابزار  Drawاي ترسیم گردند. این کار توسط منوي پس از اینکه مشخصات مدل تعریف شد، باید اجزاي سازه

 و سپسها، بعد تیرها ستوناي به ترتیب ابتدا براي ترسیم اعضاي سازه شود.انجام می ETABSسمت چپ برنامه 

توان از پنجره سمت چپ استفاده کرد. در پنجره شوند. براي رسم هندسه مدل میمیترسیم  ها و دیوارهاي برشیسقف

  شود.سمت راست نماي سه بعدي ساختمان نشان داده می

  
  

  هاي مختلف ببینید.توانید هندسه مدل را به صورتتوسط دستورات زیر می
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  اي را در حالات مختلف رسم کنیمهاي مختلف سازهتوانید المانبا استفاده از دستورات زیر می

  
  .ترسیمات را در یک طبقه، طبقات مشابه و یا همه طبقات انجام دهیدتوان می PLANدر حالت 

  
  هاستونترسیم  -4-1

پلان دهیم. روي دکمه ها را نشان میکنیم. جهت یادآوري دوباره مشخصات ستونهاي سازه را رسم میابتدا ستون

را اجرا کرده از پنجره ظاهر شده در گزینه  کنید. حال دستور  OKرا انتخاب کرده  Story1کلیک کرده و 

property  ستونC40x40 .را انتخاب کنید  

به معنی دو سرگیردار است  usoContinuحالت (آزادسازي لنگر) وجود دارد.  Moment releaseدو حالت براي 

براي این است که ستون  Angleحالت  باشند).و سر مفصل است (ستونها دوسرگیردار میبه معنی د Pinnedو حالت 

اي نسبت براي این است که ستون با یک فاصله Plan offsetحالت  اي نسبت به محور افقی رسم شود.با یک زاویه

  به نقطه کلیک شده رسم شود.
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نجام شود. بعد مطابق پلان پروژه در نقاط باشید تا ترسیمات در همین طبقه ا الت دقت کنید که در ح 

هم یک باکس بکشید تا  Grid Lineتوانید دور هر ها رسم شوند. میها کلیک کنید تا ستونGrid Lineتلاقی 

 سپسشوند. هاي طبقه اول به صورت زیر ترسیم میتر هست!!). در نهایت ستونستون رسم شود (هر کدام که راحت

نید تا به طبقات بالاتر رفته و در هر طبقه ستون با مقطع مناسب را مطابق جدول زیر استفاده ک از دستورات 

  ترسیم کنید.

  درصد میلگرد ستون  میلگرد ستون  ستون  تیر  

 2.54 16�18  40×40 40×40  سقف اول

  2.49 12�18  35×35  35×35  سقف دوم و سوم

  2.68 12�16  30×30  30×30  و خرپشته سقف چهارم

  

      

  
کنیم. شماي کلی مدل به صورت زیر خواهد بود. گزینه هاي خرپشته را رسم میو در نهایت در سقف طبقه آخرستون

Angle گزینه براي چرخاندن ستون به اندازه یک زاویه مشخص است .Offset  براي ترسیم ستون به فاصله نیز

  باشد.می Yو  Xمشخص از 
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  ترسیم تیرها -4-2

کنیم. باکلیک بر رو را اجرا می ا ترسیم شوند. پس در پلان طبقه اول قرار گرفته و دستور در مرحله بعد باید تیره

Grid Lineتوان با کلیک بر روي شوند. دقت کنید در مورد تیرهایی که نمیهاي مربوطه تیرهاي سقف رسم می

Grid Line  در  توجه به جدول رسم کنید. تیرهاي هر طبقه را با استفاده کرد. آنها را رسم کرد باید از دستور

باشد یعنی تیرها به صورت دو سر مفصل هستند. ولی  pinnedبه صورت  Moment releaseتیرهاي فولادي باید 

  باشند.باشد. چون تیرها دو سر گیردار می continuousبتنی باید به صورت  تیرهاي در

  

  

گزینه  Object assignmentرا اجرا کرده و در سربرگ  تیرها را ببینید، دستور  Labelبراي اینکه بتوانید 

Section دیگر  هايتوانید گزینهها نمایش داده شود. توسط این دستور میرا تیک بزنید تا نام مقاطع تیرها و ستون

  نمایش در مدل را تنظیم کنید.
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اد. تیرهاي طبقات بالایی را تغییر دتوان تیرهاي طبقه اول را که ترسیم شده، به طبقات بالایی کپی کرد و مقطع می

 Select/ Properties/ Frmaeبه این صورت که ابتدا تمام تیرهاي طبقه اول را انتخاب کرده (با استفاده از دستور 

Section 40) تیرهايX40  را انتخاب کرده و سپس با استفاده از دستور(Edit/Replicate/Story)  تمام تیرها

باشند ولی تیرهاي طبقات بالایی می 40X40کنیم. تیرهاي کپی شده داراي مقطع پی میک 5تا  2را به طبقات 

مقاطعشان متفاوت است. پس باید تیرهاي طبقات بالاتر را انتخاب کرده و مقطعشان را با استفاده از دستور 

Assign/Frame/Section Property  تغییر دهیم. درStory5 قط تیرهاي تیرهاي اضافی باید پاك شوند و ف

  هاي خرپشته باقی بماند.پیرامون ستون

  هاترسیم سقف -4-3

که مستطیل شکل نیستند،  هاییپانلبراي این است که در  ها سه حالت وجود دارد. حالت اول ترسیم سقف براي

ي مستطیل شکل با استفاده از دو گوشه هايپانل ي آن رسم شود. در حالت دوم سقف با استفاده از چهار گوشه

رسم  Grid Lineي خطوط در محدودهبا کلیک براي این است که سقف  شوند، و حالت سوم آن ترسیم می

ت بهتر اس باشند.اي میهاي داراي شکل ذوزنقهچون برخی از پانل کنیمهر سه حالت استفاده میدر این پروژه از  شود.

ر است و بارهاي سقف را به صورت منوازن بین تمام ریزي شطرنجی استفاده کنیم چون اقتصادي تبراي سقف از تیرچه

 کنیم.قرار گرفته و سقفها را ترسیم می All Storiesي ترسیم سقف طبقات مشابه در حالت براکند. تیرها توزیع می

   است. Deck2از نوع  و خرپشته است و سقف بام Deck1از نوع  چهارمسقف طبقات اول تا 

چرخانیم. با استفاده از دستور درجه می 90خواهیم هاي را که میا رسم کرده و بعد سقفهبراي ترسیم ابتدا تمام پانل

براي رسم یک سقف  کشیم.هاي غیر مربعی را میپانل کنیم. بعد با استفاده از دستور مربعی را ترسیم می 

بتوانیم سقف مورد نظر را رسم کنیم. کنیم تا کپی می Xمتر در جهت  1.8-در دهانه مجاور پله یک تیر پله را با اندازه 

تایپ  dxرا در باکس  1.8-کنیم. عدد را اجرا می Edit > Replicateبراي این کار تیر را انتخاب کرده و دستور 

  کنیم.می OKکرده و 
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ها رو یکی قفبعد از این باید جهت تیرچه ریزي س رسم کنیم. توانیم در این دهانه سقف را توسط دستور حال می

 Assign > Shell > Localخواهیم انتخاب کرده و دستور هایی را که میدر میان دوران دهیم. بنابراین سقف

Axes  دهیم. چون در حالت درجه را می 90را اجرا کرده و زاویهAll Stories این در تمام طبقات و همچنین  بوده

قرار گرفته و تمام  One Storyرا پاك کنید. پس در حالت  روي کف زمین هم سقف رسم شده است و باید اینها

را پاك کنید. تیر کپی شده در سقف خرپشته را نیز  (Story5)و پلان خرپشته  (Base)هاي زاید در همکف سقف

پذیر است. در نهایت سقف خرپشته را هم رسم کنید. پس از اینکه امکان Deleteپاك کنید. پاك کردن با دکمه 

هاي بام و خرپشته را انتحاب کرده و تغییر دهیم. پس سقف Deck2رسم شد، باید سقف بام و خرپشته را به ها سقف

  کنیم.می OKرا  Deck2ي را اجرا کرده و گزینه Assign > Shell > Deck Sectionدستور 
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ول قرار هایی که کنسدر دهانهرتر قرار بگیرند. جهت طول دهانه بزرگتها را در به عنوان یک نکته کلی بهتر است تیرچه

ها عموما مربع شکل می باشند، لذا تمامی دهانهدر این پروژه  دهیم.ها را در جهت دهانه بزرگتر قرار میدارد، تیرچه

  هیم.ار دي بلندتر قردهانهها را در جهت ها نیز باید تیرچهکند. در کنسولریزي در هر جهت مشکلی را ایجاد نمیتیرچه

 
  ترسیم دیوارهاي برشی -4-4

هایی دیوارهاي برشی باید در دهانه .کندنیروهاي زلزله مقاومت می برابردر دیوار برشی عنصر بسیار مقاومی است که 

براي ترسیم دیوار  الامکان در آنها بازشو (یعنی درب و پنجره) وجود نداشته باشد. از دستور قرار بگیرند که حتی

خواهیم کلیک هایی که میقرار گرفته و بر روي دهانه All Storiesشود. برا ترسیم در حالت پلان و می برشی استفاده

کنیم. بهتر است دیوارهاي برشی به صورت متقارن در پلان توزیع شوند. به عنوان یک حالت مناسب چهار دیوار می

 Story1و  PLANشود. به حالت ظر گرفته میاند در نبرشی در چهار گوشه ساختمان که به طور مناسب توزیع شده

متري دیوارها را سانتی 30، با انتخاب دیوار One Storyرویم و با استفاده از دستور ترسیم دیوار برشی در حالت می

را براي دیوارها فعال کنید  Auto Pier/Spandrelدهیم. کنیم. این کار را براي دیگر طبقات نیز انجام میرسم می

  به طور خودکار اختصاص داده شود. Labelهر دیوار یک تا به 
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  و پله ترسیم تیرهاي پاگرد -4-5

 120تا  110عرض پاگرد معمولا  عدد باشد. 19یا  18تواند تعداد پله می متر باشد.سانتی 18یا  17تواند ارتفاع پله می

  متر است.سانتی 30طول پاخور معمولا  متر است.سانتی

بقاتارتفاع کف تا کف ط    = �
19 × 17�� = 323��
18 × 18�� = 324��

 

  
  .شودتایی تقسیم می 9ها در رفت و برگشت به دو ردیف تعداد پله ،پله دو گردشه باشد اگر

  
 6ي ردیف پله 3ها در هر گردش متفاوت است. ولی اگر ي سه گردشه بسته به طول و عرض دهانه تعداد پلهدر پله

  بگیریم: تایی را در نظر
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ه را سه توان پلي پله مربعی باشد، میاگر محدوده توان پله را دو گردشه گرفت.ي پله مستطیلی باشد، میمحدودهاگر 

  گردشه گرفت.

  

ارتفاع کف تا سقف براي پارکینگ باید  متر باشد.سانتی 280ارتفاع کف تا سقف براي طبقات مسکونی باید حداقل 

) همیشه یک عدد عدد 6-6-5یا  عدد 17هاي پارکینگ (تعداد پله به همین دلیل متر باشد.سانتی 260تا  240حداقل 

براي پارکینگ و طبقات پاگرد پله ارتفاعی بنابراین رقوم  ) است.عدد 6-6-6یا  عدد 18هاي طبقات (کمتر از تعداد پله

متر بگیریم سانتی 45تیرچه بلوك را  متر بگیریم و ارتفاع سقفسانتی -40حال اگر تراز روي پی را  .کندفرق می

توانیم به صورت زیر محاسبه کنیم که تیرهاي شمشیري و پاگرد در چه ترازي قرار دارند و از این تراز براي ترسیم می

هاي شمشیري طبقات باید از اعدادي که قرمز هستند کنیم. پس براي ترسیم پلهاستفاده می ETABSبرنامه در 

  استفاده کنیم.
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  پارکینگ  طبقات

18 × 18�� = 17  ارتفاع کف تا کف ��324 × 18�� =   ارتفاع کف تا کف ��306

324− 45 = −306  ارتفاع کف تا سقف ��279 45 =   ارتفاع کف تا سقف ��261

  

را اجرا کرده  ر پله وجود دارد. دستومی رویم که در آن تیرهاي راه Elevation Dرویم. به حال به سراغ مدل می

به سمت  Edir > Moveبا استفاده از دستور  (1.8m=1.3-3.1)تیر طبقه اول را به اندازه می رویم.  Dو به محور 

به سمت پایین  (0.72m=2.38-3.1)کشیم و به اندازه دهیم. دوباره همان تیر طبقه اول را میپایین انتقال می

Move له را با استفاده از دستور پکنیم. سپس دو ستون دو طرف راهمیEdit > Replicate  1.1با اندازهm  به)

  کنیم.ي عرض پاگرد) به داخل دهانه کپی میاندازه

  

  

            
 Edit > Edit Frame > Divie Frameپس از این مرحله چهار تیر و ستون داخل دهانه را انتخاب کرده و دستور 

 Break atا در محل تلاقی خود به اعضاي کوچکتر تقسیم شوند. گزینه ها و تیرهکنیم تا ستونرا اجرا می

intersections with selected frames and joints  را انتخاب کرده وOK کنیم. پس از آن خطوط اضافی می

 Edit > Replicateاین تیر را کلا انتخاب کرده و با استفاده از دستور کنیم. کرده و یک تیر مایل نیز رسم می را پاك

> Story  کنیم. باید تیرهاي پاگرد طبقه دوم و سوم را باید به کپی می 4و  3و  2آن را به طبقاتB35x35  و چهارم

 Assign > Frame > Sectionتغییر دهیم. براي این کار تیرهاي هر طبقه را انتخاب کرده، دستور  B30x30را به 
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Property توجه کنید که در طبقه خرپشته پله وجود  دهیم.به هر تیر اختصاص می را اجرا کرده و مقطع مورد نظر را

  ندارد.

و در تراز دلخواه یک پلان کمکی ایجاد توان استفاده کرد هم می Draw > Draw Reference Plane(از دستور 

  )کرد
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 با اعضا Define، اختصاص دادن مشخصات تعریف شده در Assignمنوي  -5

  دهیم.تعریف کردیم را به اعضا ترسیم شده اختصاص می Defineاین منو تمامی مشخصاتی که در منوي در 

  گاهیتعیین شرایط تکیه -5-1

و  Base Plateهاي فولادي بسته به نوع اتصال ولی در سازههاي بتنی عموما پاي ستون گیردار است. براي ستون

ها ن اتصال پاي ستون را مفصل یا گیردار در نظر گرفت. اگر تعداد بولتتواتعداد میلگردها و نحوه مهار آنها در بتن می

ن یک البته ای هاي اتصال زیاد باشد، اتصال گیرداري مناسب دارد.کم باشد اتصال مفصلی است ولی اگر تعداد بولت

اساس لنگر وارده باید محاسبات انجام شود و مقدار گیرداري بر  Base Plateحرف به نوعی عامیانه است و براي هر 

  به دست آید.

    
  اي از اتصال نسبتا مفصلینمونه  اي از اتصال نسبتا گیردارنمونه

  

کنیم و گاهی را انتخاب میهاي تکیه Jointقرار گرفته و تمام  One Storyو  BASEدر حالت  PLANدر پنجره 

  کنیم.می OKتخاب کرده و ، حالت گیردار را انرا اجرا کرده Assign > Joint > Restraintبعد 
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  ها)اختصاص مقاطع به اعضاي خطی (تیرها و ستون -5-2

  گیرد.انجام می Assign/ Frame/ Section Propertyبا استفاده از دستور 

  آزادي سازي لنگر دو سر تیرها (در رابطه با تیرهاي فلزي) -5-3

 Assignتوانیم با استفاده از دستور مفصلی است، میهاي فولادي که اتصالات تیرها و بادبندها به صورت در ساختمان

> Frame / Release/partial fixity براياین دستور براي را به صورت مفصلی تعریف کرد.  اعضاتوان دو سر می 

  را براي ابتدا و انتهاي عضو تیک زد. M33و  M22باید مقدار  شود.بادبندها و تیرهاي دو سر مفصل استفاده می

  
 
  

  

5-4- Rigid Zone factor  
 < Assignدر هر اتصال تیر و ستون در چشمه مرکزي اتصال ناحیه صلبی وجود دارد که با استفاده از دستور 

Frame > End Length Offsets تمام اعضا را انتخاب کرده و ابتدا  در این حالت. قابل تعریف استافزار نرم براي

Rigid Zone Factor  دهیم.قرار می 0.5را برابر  
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  اختصاص دیافراگم صلب -5-5

 < Select > Select > object Typeاز طریق دستور را  (DECK)ها تمام کف صلب، براي اختصاص دیافراگم

Floors  انتخاب کرده و سپس دستورAssign > Shell > Diaphragms  را اجرا کنید. دیافراگمD1  را انتخاب

  شود.هاي طبقات توسط چندین فنر صلب به مرکز جرم ساختمان متصل میحالت تمام گرهکنید. در این  OKکرده و 

تی ح باید پیچش تصادفی در ترکیبات بارگذاري لحاظ شود.حتما  ،اگر دیافراگم تعریف کنیم 2800نامه بر اساس آیین

 متر).  18یا کوتاهتر از  طبقه 5رعایت شده باشد (ساختمان تا  4-10-3-2در صورتی که در ساختمان، ضوابط بند 

        

  
هایی که صلبیت لازم را ندارند باید دو یا چند دیافراگم به کف اختصاص دهیم و اختصاص یک دیافراگم کار در سقف

  اشتباهی است.
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 بارگذاري ثقلی (مرده) دیوارها -5-6

 که این جزئیات در دسترس نباشدورتیها باید از روي جزئیات معماري به دست بیاید. ولی در صبارگذاري دیوارها و کف

ها رایج و متداول است، استفاده ( که عموما هم در دسترس نیست) باید از یک دیتایل معقول که در اجراي ساختمان

  کرد. 

 در ساختمانشوند. متر بیشتر است، در نظر گرفته میسانتی 20براي بارگذاري دیوارها تنها دیوارهایی که ضخامتشان از 

نما ندارند ولی دیوار . دیوارهاي داخلی سنگشوندبندي میي دیوار خارجی و دیوار داخلی تقسیمرها به دو دستهدیوا

د. جزئیات این دیوار به صورت زیر است. براي محاسبه وزن مخصوص اجزاي تشکیل نباشخارجی داراي سنگ نما می

  استفاده کرد.» قررات ملی ساختمانمبحث ششم م 1-6پیوست شماره «ي این دیوارها باید از دهنده

  :سانتیمتري خارجی نمادار 22دیوار دتایل بار 

248240002.0
m

kg   سنگ نما تراورتن 

263210003.0
m

kg   ملات ماسه سیمان 

217085020.0
m

kg   آجرکاري با آجر مجوف و ملات ماسه سیمان 

25.191300015.0
m

kg   ملات گچ سفید 

2241600015.0
m

kg   ملات گچ و خاك 

2320324
m

kgmkg    مجموع 

 
  :سانتیمتري خارجی بدون نما 22دیوار دتایل بار 

217085020.0
m

kg   آجرکاري با آجر مجوف و ملات ماسه سیمان 

25.191300015.0
m

kg   ملات گچ سفید 

2241600015.0
m

kg   ملات گچ و خاك 

2220214
m

kgmkg    مجموع 

 
  سانتیمتري: 22تیغه دتایل بار 

25.191300015.0
m

kg   گچ سفید 
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2241600015.0
m

kg   ملات گچ و خاك 

217085020.0
m

kg   آجرکاري با آجر مجوف و ملات ماسه سیمان 

25.191300015.0
m

kg   گچ سفید 

2241600015.0
m

kg   ملات گچ و خاك 

2260257
m

kgmkg    مجموع 

 

وزنی که در جداول بالا به دست می آید وزن واحد سطح است و باید در ارتفاع دیوار ضرب شود تا وزن واحد طول 

متر سانتی 50متر است. پس با احتساب ضخامت  20/3 تقریبا با توجه به اینکه ارتفاع کف تا کفدیوار به دست بیاید. 

هایی که داراي بازشو هستند وزن کمتري نسبت به دیوارهاي به دست خواهد آمد. دیوار 7/2ر برابر براي کف، ارتفاع دیوا

دیوار  .کنیممیلحاظ  در جدول زیر را براي محسوب کردن بازشوها 7/0ضریب بدون بازشو دارند. به همین دلیل 

ها ريسپس این بارگذاشود. ش بر دو میخارجی روي پاگرد به دلیل اینکه ارتفاعش نصف ارتفاع طبقه است، وزن آن بخ

   اشتباهی رخ ندهد. ETABSکنیم تا در وارد کردن آنها در برنامه را روي پلان مشخص می

×320 دیوار خارجی نمادار 2.7 = 864�� �⁄  

0.7 دیوار خارجی نمادار با بازشو × 320× 2.7 = 605�� �⁄  

×220 دیوار خارجی 2.7 = 594�� �⁄  

0.7 وار خارجی با بازشودی × 220× 2.7 = 416�� �⁄  

260  سانتی 22دیوار تیغه  × 2.7 = 702�� �⁄  

0.7  سانتی با بازشو 22دیوار تیغه  × 260 × 2.7 = 492�� �⁄  

×320 روي پاگرد نمادار دیوار خارجی 2.7/2 = 432�� �⁄  

  

  وي تیرها:ها بر ربار مرده دیوار پلان بارگذاري
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5-7- Laod Case Wall براي تیرهاي طبقه آخر 

به تیرهاي طبقه بام و خرپشته اختصاي دهیم. مقدار این  Wallقبلا گفتیم که براي اصلاح مرکز جرم باید یک بار 

  تر است.بار دیوارهاي طبقه پایین فبار دقیقا نص
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  هاو بار قائم زلزله در بالکن )و زنده مردهبار ( هاکف بارگذاري ثقلی -5-8

آید که سقف طاق ضربی یا سقف کامپوزیت داشته باشیم. هاي از نوع تیرچه بلوك هستند و کمتر پیش میما سقفعمو

 100ا نیز هشوند. به وزن کفي بلوك سیمانی و بلوك یونولیتی تقسیم میهاي تیرچه بلوك نیز به دو دستهسقف

  شود.اضافه می نیز تیغه بارکیلوگرم بر متربع 

  تیرچه بلوك سیمانی طبقات: سقف دتایل بار مرده

242210002.0
m

kg  کاشی سرامیکی کفی  

25.522100025.0
m

kg   ملات ماسه سیمان 

291130007.0
m

kg   ي معدنیبتن با پوکه 

2125250005.0
m

kg   دال بتن مسلح 

2125250025.010.02
m

kg   تیرچه بتنی 

280108
m

kg  یمانی بلوك س 

2241600015.0
m

kg   ملات گچ و خاك 

25.191300015.0
m

kg   گچ سفید 

2100
m

kg   بار تیغه 

22 660659 mkgmkg    مجموع 
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  تیرچه بلوك سیمانی بام (سقف بام بار تیغه ندارد): دتایل بار مرده سقف

20.02 2200 44 kg
m

    آسفالت  

215 kg
m

   دولایه قیرگونی 

291130007.0
m

kg   ي معدنیبتن با پوکه 

2125250005.0
m

kg   دال بتن مسلح 

2125250025.010.02
m

kg   تیرچه بتنی 

280108
m

kg  بلوك سیمانی  

2241600015.0
m

kg   ملات گچ و خاك 

25.191300015.0
m

kg   گچ سفید 

2 2523 520kg m kg m    مجموع 

  :تیرچه بلوك یونولیتی دتایل بار مرده سقف

242210002.0
m

kg   کاشی سرامیکی کفی 

25.522100025.0
m

kg   ملات ماسه سیمان 

291130007.0
m

kg   ي معدنیبتن با پوکه 

2125250005.0
m

kg   دال بتنی 

2125250025.010.02
m

kg   چه بتنیتیر 

22
m

kg  بلوك یونولیتی  

250
m

kg   سقف کاذب با اندود گچی 

2100
m

kg   بار تیغه 

22 585587 mkgmkg    مجموع 

 باید بار بتن سقف را از پسکند. مقدار بار بتن را از روي مشخصات سقف تیرچه بلوك محاسبه می ETABSبرنامه 

در صورتی که سقف بام از نوع  .کیلوگرم بر متر مربع باشد) 650(بار مرده کف طبقات نباید زیر  بار کل سقف کم کنیم

کیلوگرم  150ي سربندي را معادل توان بار گستردهباشد، می (سربندي چوبی) بلوك نباشد و فقط خرپاي چوبیتیرچه

  بر مترمربع در نظر گرفت.



108 

 

کیلوگرم بر متربع است. با توجه به محل  200ی مطابق با مبحث ششم مقررات ملی برابر ي طبقات مسکونبار زنده

مبحث  5-2-3-6مطابق بند  کیلوگرم بر متر مربع خواهد بود. 200پروژه که در شهر رشت است، مقدار بار برف برابر 

  کمتر باشد.کیلوگرم بر مترمربع  300نباید از  ها نیزبالکنرات ملی ساختمان بار زنده مقر 6

  شود:نوشته میهاي به شرح زیر ي بارگذاريبنابراین خلاصه

�� طبقاتسقف بار مرده  = 660 − (125+ 125)= 410�� ��⁄  

��  بار مرده سقف بام = 520− (125+ 125)= 270�� ��⁄  

�� بار مرده بالکن = 410�� ��⁄  

 

��  بار زنده طبقات = 200�� ��⁄  

��  بار زنده بام (برف) = 200�� ��⁄  

��  بار زنده بالکن = 300�� ��⁄  

ها الکنبارگذاري بها نیز محاسبه شود. ي قائم نیروي زلزله باید بر روي بالکنکند که مولفهتصریح می 2800نامه آیین

ن پروژه بالکن نداریم، پس بار قائم زلزله بر ساختمان وارد یروي قائم زلزله به صورت زیر است. چون در ایدر اثر ن

  شود.نمی

�� = 2 × 0.7 × ���� 

A شتاب مبناي طرح :  ،  I ضریب اهمیت ساختمان :    ،  Wp + کل بار زنده(: بار مرده(  

�� = 2 × 0.7 × ���� = 2 × 0.7 × 0.3 × 1 × (660 + 300)= 405�� ��⁄  براي طبقات مسکونی  

�� = 2 × 0.7 × ���� = 2 × 0.7 × 0.3 × 1 × (520+ 300)= 345�� ��⁄  براي طبقات مسکونی  

  در ترکیب بار قائم با بار مرده و زنده باید به صورت زیر عمل کرد تا بار قائم زلزله بیشترین تاثیر را داشته باشد.

� + � + ��    ↓ 
� − ��   ↑ 

  پشته به صورت زیر خواهد شد:پلان بارگذاري کف طبقات، بام و خر

  
 پلهبارگذاري ثقلی راه -5-9
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با تقریب خوبی آید. پله به صورت زیر به دست میي راهمتداول، بار مرده و زنده هايعموما با توجه به جزئیات پله

  اد.دتوان بار اتاق پله را به دو قسمت تقسیم کرد و بارها را به تیرهاي طبقه و تیرهاي شمشیري پله اختصاص می

��680  بار مرده پله �⁄  

��350 بار زنده پله �⁄  

�4ابعاد اتاق پله  × �1.3است. مساحت اتاقک آسانسور  �3.6 × است. پس کل بار اتاق پله به صورت زیر  �1.6

  شود تا به طور مساوي میان تیرهاي دو طرف تقسیم شود:محاسبه شده و بخش بر دو می

�� =
680 × (4 × 3.6 − 1.3 × 1.6)

2 × 4
= 1050��

�
 

�� =
350× (4 × 3.6 − 1.3 × 1.6)

2 × 4
= 540��/� 

  شود. به همین دلیل بارگذاري فوق براي طبقه بام نصف خواهد شد.فقط در طبقه بام (نه خرپشته) پله قطع می

�� =
680 × (4 × 3.6 − 1.3 × 1.6)

2 × 2 × 4
= 525��

�
 

�� =
350× (4 × 3.6 − 1.3 × 1.6)

2 × 2 × 4
= 270��/� 

 

  

  
 اختصاص بار به تیرها -5-10

تغییر دهیم تا احتیاجی به تبدیل واحد نداشته باشیم. پس دستور  Kgf/mبرا اختصاص بار بهتر واحدها را بر حسب 

  دهیم.تغییر می mو  kgfرا اجرا کرده و واحدها را به  Consistent unitsو سپس  
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 < Assignبه تیرها، باید ابتدا تیرهاي مورد نظر را انتخاب کرده و سپس دستور  براي اختصاص بارهاي گسترده

Frame Laod > Distributed کنیم. نیرو را از نوع را اجرا کنیم. در این پنجره نوع بار (مرده یا زنده) انتخاب می

Force کنیم و جهت آن را تنظیم میGravity گیریم. سه در نظر میOption بارگذاري وجود دارد به  براي این

 Replace)یا اینکه جایگزین بارهاي قبلی شوند  (… Add to)این صورت که این بار به بارهاي قبلی اضافه شوند 

to …)  و یا اینکه این بارها حذف شوند(Delete …) مقدار بار گسترده را در قسمت .Uniform Laod  وارد

  اي می باشند. هایی است که خطی نیستند و به صورت خطی و ذوزنقهبراي بارگذاري Trapezoidalکنیم. حالت می

هاي صفحات قبل باید تک به تک توسط این دستور به تیرها اختصاص یابد. این کار را خودتان انجام تمامی بارگذاري

  دهید.

  
  هااختصاص بار به سقف -5-11

گیرد. براي این انجام می Assign > Shell load > uniformها توسط دستور اختصاص بارهاي گسترده به سقف

هایی را که بارشان یکسان است انتخاب کنید. سپس دستور قرار گرفته و کف Similar Storiesمنظور در حالت 

Assign > Shell Load > uniform  را اجرا کنید. حالت بار ( مرده یا زنده) را انتخاب کرده و مقدار بار را وارد

نیز براي این دستور  ADdd, Replace, Deleteباشد. سه حالت  (Gravity)جهت ثقلی  کنید. جهت بار باید در

  وجود دارد.
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 گفت فولاد بتن را روزي *** که تو این قدر چرا مرموزي؟

 در کشش مثل لبو می مانی *** در خمش هم که خودت می دانی

 گفتی از علم تخطی نکنی *** پس چرا کرنش خطی نکنی؟

 تا مسلح نشوي از فولاد *** تویی و این همه عیب و ایراد

 چین است made in تت پایین است *** اصلا انگار کهغالبا کیفی

 کنترل کرده کسی جان تو را؟ *** نسبت آب به سیمان تو را؟

 آخر این قدر تخلخل از چیست؟ *** غالبا ویبره ات کافی نیست

 چند روزي همه سرگردانند *** تا عمل آوري ات گردانند

 ناظر و کارگر و کارآموز *** آب باید بدهندت هر روز

 حرف من را بشنو باور کن *** برو ورزش بکن و لاغر کن

 شده ابعاد تو بسیار زیاد *** مثلا تیرِ نود در هفتاد

 سازه هاي بتنی سنگین است *** سرعت ساختشان پایین است

 در جوابش بتن آمد به سخن *** گفت آخر تو چه دانی از من؟

 و زنگگرچه از آبم و سیمانم و سنگ *** هرگز اما نزنم مثل ت

 بیخودي مثل تو کرنش نکنم *** زیر هر بار کمانش نکنم

 نیست فولاد خفن تر از من *** من نمی ترسم از آتش اصلا

 اتصالات درونت ناجور *** هیکلت پر شده از جوش غرور

 سخنی بین من و بین تو نیست*** هر چه باشد پی ات آخر بتنی است

 


